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Communications & Safety Regulation Information

Compliance Statement

 

The model SYNC I/O complies with the following standards 
regulating interference and EMC:
• FCC Part 15 Class A
• EN55103 – 1, environment E4
• EN55103 – 2, environment E4
• AS/NZS 3548 Class A
• CISPR 22 Class A

 

Radio and Television Interference

 

This equipment has been tested and found to comply with the 
limits for a Class A digital device, pursuant to Part 15 of the 
FCC Rules. 

 

Communications Statement

 

This equipment has been tested to comply with the limits for a 
Class A digital device. Changes or modifications to this product 
not authorized by Digidesign, Inc., could void the Certification 
and negate your authority to operate the product. This product 
was tested for CISPR compliance under conditions that 
included the use of peripheral devices and shielded cables and 
connectors between system components. Digidesign 
recommends the use of shielded cables and connectors 
between system components to reduce the possibility of 
causing interference to radios, television sets, and other 
electronic devices.

 

Safety Statement

 

This equipment has been tested to comply with USA and 
Canadian safety certification in accordance with the 
specifications of UL Standards; UL6500 and Canadian CSA 
standard; CSA C22.2 No.1-M90. Digidesign Inc., has been 
authorized to apply the appropriate UL & CUL mark on its 
compliant equipment.

 

Important Safety Instructions

 

When using electric or electronic equipment, basic precautions 
should always be followed, including the following:
• Read all instructions before using this equipment.
• To avoid the risk of shock, keep this equipment away from 

rain water, and other moisture. Do not use this equipment 
if it is wet.

• The equipment should only be connected to the correct 
rating power supply as indicated on the product.

• Do not attempt to service the equipment. There are no 
user-serviceable parts inside. Please refer all servicing to 
authorized Digidesign personnel.

• Any attempt to service the equipment will expose you to a 
risk of electric shock, and will void the manufacturer’s 
warranty.

• The product should be connected only to the correct power 
supply as indicated on the product.
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chapter 1

Introduction
Welcome to the Digidesign SYNC I/O, a multi-
purpose synchronization peripheral for 
Pro Tools|HD™ systems. The SYNC I/O supports 
all Pro Tools|HD sample rates, and synchronizes 
to all major time code and clock reference stan-
dards used in audio, video, film, and multime-
dia production. 

SYNC I/O is designed especially for 
Pro Tools|HD systems, but it can also be utilized 
as a stand-alone synchronization device. When 
used with Pro Tools, most SYNC I/O features 
can be controlled from within the Pro Tools ap-
plication. In addition, a utility application 
(SYNC I/O Setup™) is provided which gives 
software access to all SYNC I/O parameters re-
motely, with or without Pro Tools. Even with-
out a computer, SYNC I/O can be configured 
manually using its front panel switches and dis-
plays. 

SYNC I/O with Pro Tools

With Pro Tools|HD, SYNC I/O provides highly 
accurate lock to time code through the DigiSer-
ial Port connection to the HD Core card. Most 
SYNC I/O settings are available directly from 
within Pro Tools. 

When the SYNC I/O is used with 
Pro Tools|24 MIX or Pro Tools|24, it supports all 
features of (and emulates on-screen) the Digide-
sign USD (Universal Slave Driver). 
Stand-alone Mode

SYNC I/O can be used as a stand-alone synchro-
nization converter, time code generator, clock 
generator and time code character generator. 
Throughout this guide, the term “stand-alone” 
refers to systems utilizing SYNC I/O but not us-
ing Pro Tools. SYNC I/O is connected to time 
code and clock signals as needed, and config-
ured from the front panel. Optionally, 
SYNC I/O Setup software can be run from a sup-
ported Macintosh or Windows computer for 
software remote control of all SYNC I/O param-
eters.

SYNC I/O Setup Software

The SYNC I/O Setup software is a remote con-
trol application for SYNC I/O. SYNC I/O Setup 
can be used with or without Pro Tools on any 
supported Macintosh or Windows computer. A 
Macintosh serial port is required. 
SYNC I/O Setup is not supported through the 
DigiSerial port. SYNC I/O Setup can also be in-
stalled and run from a Windows computer with 
the appropriate cable (see “SYNC I/O Setup” on 
page 2 for more information).
Chapter 1: Introduction 1
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System Requirements

Pro Tools|HD

Macintosh

• A Digidesign-qualified Power Macintosh com-
puter

• A Pro Tools|HD system

• Pro Tools software version 5.3.1

Windows 

• A Digidesign-qualified Windows computer

• A Pro Tools|HD system 

• Pro Tools software version 5.3.1

Pro Tools|24 MIX and Pro Tools|24

The SYNC I/O can be used with 
Pro Tools|24 MIX and Pro Tools|24 systems. 
When used with these systems, the SYNC I/O 
emulates the Digidesign Universal Slave Driver 
(USD). Only features supported by Pro Tools|24 
MIX, Pro Tools|24, and the USD will be avail-
able. 

Macintosh

• A Digidesign-qualified Power Macintosh com-
puter

• A Pro Tools|24 MIX, or Pro Tools|24 system

• Pro Tools software version 5.1.3 or later

Windows 

• A Digidesign-qualified Windows computer

• A Pro Tools|24 MIX, or Pro Tools|24 system

• Pro Tools software version 5.3.1
SYNC I/O Guide
SYNC I/O Setup 

(Macintosh and Windows) 

The optional SYNC I/O Setup application re-
quires a serial connection from SYNC I/O to 
your computer. SYNC I/O Setup is not available 
through the DigiSerial port. 

SYNC I/O Setup provides stand-alone software 
control of SYNC I/O, and firmware updating ca-
pabilities. SYNC I/O Setup can be used with or 
without Pro Tools for complete control of all 
SYNC I/O features. 

Macintosh

• A Power Macintosh computer running Macin-
tosh OS 9 or later (OS X is not supported at 
this time)

• At least 2 MB of available RAM

• Virtual Memory must be turned off in the 
Macintosh Memory Control Panel

• An available serial (modem or printer) port, or 
equivalent USB converter. See “Serial Port Re-
quirements” on page 3 for details.

Windows

• A Pentium-I, 90 MHz computer, running ei-
ther Windows 98SE, Windows Me, Windows 
NT4, or Windows 2000 

• An available COM port. See “Serial Port Re-
quirements” on page 3 for details.

• A custom Serial-to-COM cable. See “SYNC I/O 
Serial Cable Pin Assignments” on page 87 for 
wiring information. 



                           
Serial Port Requirements 

Pro Tools|HD Systems

◆ SYNC I/O requires a Host Serial port on the 
system’s HD Core card. 

Pro Tools|24 MIX and Pro Tools|24 Systems

◆ SYNC I/O requires a DigiSerial Port on the sys-
tem’s MIX Core or d24 “Core” card. (If using an 
expanded Pro Tools|24 system that includes a 
MIX Farm card, use the DigiSerial Port on the 
MIX Farm card.)

SYNC I/O Stand-alone, without Pro Tools

If you are not using Pro Tools, but are using 
SYNC I/O in stand-alone mode, you can use the 
front panel controls, or SYNC I/O Setup. 
SYNC I/O Setup provides total control of all 
SYNC I/O parameters. 

Not all parameters and options can be config-
ured using the front panel only. The following 
SYNC I/O parameters are available only through 
SYNC I/O Setup, or Pro Tools:

◆ Variable Speed Override (VSO)

◆ Window burn parameters. While you can turn 
the Window burn on or off from the front 
panel, you cannot configure its display parame-
ters without Pro Tools or SYNC I/O Setup. 

See “SYNC I/O Controls in Pro Tools, 
SYNC I/O Setup and the Front Panel” on 
page 32 for more information.
Serial Port Requirements for Using the 
SYNC I/O Setup Application

(Macintosh and Windows)

In order to use SYNC I/O Setup, you must have 
the following:

Macintosh  A serial port (modem or printer, or 
equivalent serial port adaptor) is required for the 
SYNC I/O Setup application on Macintosh. 

Since Power Macintosh G3 and G4 computers 
do not contain a conventional serial port, where 
connection to a conventional Macintosh serial 
port (modem or printer port) is called for in this 
guide, you will need to utilize one of the follow-
ing adaptors:

• Stealth Serial Port, made by GeeThree.com.

• gPort Serial Adaptor, made by Griffin Technol-
ogy. 

• USB Twin Serial Adaptor, model USA-28x, 
made by Keyspan. 

Windows A COM port connection is required for 
the SYNC I/O Setup application on Windows. 
SYNC I/O Setup does not work if SYNC I/O is 
connected to a DigiSerial port. 

SYNC I/O Cables

SYNC I/O Serial Cable  A Host Serial cable is in-
cluded to connect SYNC I/O to a the DigiSerial 
Port on a Pro Tools|HD Core, MIX Core, or d24 
card, or MIX Farm when one is present in an ex-
panded Pro Tools|24 system. This cable is a stan-
dard Macintosh serial cable. 

Windows  SYNC I/O Setup on Windows requires 
a non-standard 8-pin to 9-pin cable to connect 
SYNC I/O to a COM port on any supported Win-
dows computer. Wiring instructions for making 
the required cable can be found in Appendix C, 
“Wiring Diagrams Pin Assignments.”
Chapter 1: Introduction 3



  

4

             
SYNC I/O Features
SYNC I/O supports all Pro Tools|HD sample 
rates, including 88.2, 96, 176.4, and 192 kHz. 
SYNC I/O provides the following synchroniza-
tion features. 

Supported Positional Reference Sources

• LTC 

• VITC 

• Bi-phase/Tach

• Internal Time Code Generator

• Serial Time Code 

Supported Clock Reference Sources

• Loop Sync

• Reference Video

• Composite Video Input

• Word Clock

• AES/EBU Null

• Pilot Tone

• Internal Crystal

• Bi-phase/Tach

• LTC

Output and Generation

• Digidesign Super Clock (256x sample clock)

• Word Clock (1x sample clock)

• AES/EBU null clock (AES “digital black”)

• VITC (if a video input is present)

• LTC

• MIDI Time Code (MTC)

• Two 9-pin Sony P-2 machine protocol ports, 
for MachineControl™-enabled systems. 
SYNC I/O Guide
Other Features

• Front panel controls and a large LED display 
of time code and parameters

• Integrated control of SYNC I/O from 
Pro Tools

• Time Code Character Generator

• Remote 9-Pin Deck Emulation mode

• Fader start, provided through GPI output, for 
remote transport control from select Pro Tools 
fader movement. 

• SYNC I/O Setup software for Macintosh and 
Windows

• SYNC I/O firmware that can be updated at 
any time for future upgrades

Compatibility Information 
Digidesign can only assure compatibility and 
provide support for devices it has tested and ap-
proved. 

For a list of qualified computers, diskette drives, 
SCSI accelerators, serial port convertors, and 
hard drives, refer to the latest Digidesign com-
patibility documents, available from Digidesign 
by fax or on the Digidesign Web site. 

For a list of Digidesign’s contact informa-
tion, see the title page of this guide. 



            
About This Guide
This guide assumes you understand the basics of 
synchronization and time code, know how to 
operate devices that send or receive time code 
such as a video tape recorder, and how to con-
nect your studio. Refer to the documentation 
for your studio hardware if necessary. In addi-
tion, you should have an understanding of the 
time code requirements for your particular 
project. 

Conventions Used in This Guide

Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:

The following symbols are used to highlight im-
portant information: 

Convention Action

File > Save Session Choose Save Session 
from the File menu

Control+N Hold down the Control 
key and press the N key

Option-click Hold down the Option key 
and click the mouse but-
ton

Right-click (Windows) Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your system.

Important Notices include information that 
could affect your data or the performance of 
your system.

Cross References point to related sections 
in other Digidesign guides.
Chapter 1: Introduction 5
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chapter 2

Installation and Getting Started
SYNC I/O installation includes the following 
steps:

Hardware Connecting power, serial, clock, and 
time code to and from SYNC I/O, Pro Tools, and 
your other studio equipment. 

Software Checking Pro Tools software, and in-
stalling SYNC I/O Setup software.

For standalone SYNC I/O systems, hardware in-
stallation instructions begin with “Hardware 
Connections” on page 7. Optional software in-
stallation instructions for remote control 
through the SYNC I/O Setup software can be 
found in “Software Installation” on page 14.

Once installed, Pro Tools needs to be configured 
for SYNC I/O. For instructions on how to set up 
Pro Tools for SYNC I/O, see “Getting Started 
with Pro Tools|HD and SYNC I/O” on page 14. 

Make sure Pro Tools is already installed 
and operating correctly before installing the 
SYNC I/O. 
Hardware Connections 
The following are the primary hardware connec-
tions required for SYNC I/O:

• AC Power 

• Host Serial, to Pro Tools or computer

• Clock to Pro Tools audio interfaces

• 9-pin, to external machines (requires Machi-
neControl™)

• Synchronization, including positional and 
clock references to and from machines, decks, 
and other devices

Pro Tools installations require all types of con-
nections. Stand-alone operation requires power 
and synchronization connections, with serial 
connection optional (for remote control using 
SYNC I/O Setup software). 
Chapter 2: Installation and Getting Started 7
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AC Power

The SYNC I/O AC connector accepts an IEC 
Standard AC Power Cable. SYNC I/O is auto 
power-selecting (100V to 240V) and will auto-
matically work with a standard modular cable to 
connect to AC power receptacles in any country. 

To connect AC power to SYNC I/O:

■ Plug one end of a power cable into the 
SYNC I/O AC connector, and plug the other end 
into a wall outlet or other power source. 

Serial Connections 

Pro Tools systems require a serial connection be-
tween SYNC I/O and the Pro Tools|HD Core 
card. Stand-alone setups (or any installation uti-
lizing SYNC I/O Setup software) require a serial 
connection between SYNC I/O and a standard 
serial port on the host CPU (modem or printer 
port on Macintosh, or a COM port on Windows 
computers). 

About the SYNC I/O Serial Cable 

Host Serial SYNC I/O includes a 4 meter (ap-
proximately 12 foot) standard Macintosh serial 
cable, to connect SYNC I/O to a DigiSerial Port 
on a Pro Tools|HD Core card. 

For SYNC I/O Setup software on Macintosh, use 
the same standard serial cable. 

For SYNC I/O Setup on Windows systems, a cus-
tom 8-pin to 9-pin cable is required to connect 
SYNC I/O to a Windows COM port. 

If you choose to use a longer serial cable be-
tween Pro Tools and SYNC I/O, be sure it 
supports hardware handshaking. Wiring di-
agrams can be found in Appendix C, “Wir-
ing Diagrams Pin Assignments.”
SYNC I/O Guide
MachineControl and SYNC I/O

SYNC I/O provides two 9-pin pass-through 
ports which are designed for use with Digide-
sign’s MachineControl software. If you use Ma-
chineControl with your Pro Tools|HD system, 
see “9-Pin for MachineControl” on page 11 for 
important instructions. 

Serial to Pro Tools 

To connect SYNC I/O to a Pro Tools|HD system:

1  Make sure power is off on all equipment. 

2  Connect one end of the Host Serial cable to 
the SYNC I/O Host Serial port.

3  Connect the other end to the DigiSerial port 
on your HD Core card. Do not use any other 
DigiSerial ports on other HD-series cards.

To connect SYNC I/O to a Pro Tools|24 MIX or 
Pro Tools|24 system:

1  Make sure all your equipment is powered off 
(including your computer, SYNC I/O, and all 
Pro Tools hardware). 

2  Connect one end of the DigiSerial cable to the 
SYNC I/O Host Serial port (whether using a Mac-
intosh or a Windows computer).

Host Serial connection, SYNC I/O to Pro Tools|HD

MTC OUTHOST SERIAL

AC 100-240V, 50-60HZ, .5A 30W
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OUT

IN
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LOOP SYNC

INTERNALLY 
TERMINATED

BI-PHASE / TACH / GPI / PILOT

SERIAL NUMBER

964530300294856

Host Serial 

SYNC  I/O 

DigiSerial Port on
Pro  Tools|HD  Core



       
3  Connect the other end of the cable to the 
DigiSerial Port on your MIX Core or d24 card. (If 
using an expanded Pro Tools|24 system that in-
cludes a MIX Farm card, use the DigiSerial Port 
on the MIX Farm card. See your Expanded Sys-
tems Guide for more information.)

4  Connect the rest of your equipment to 
SYNC I/O as described in “Synchronization and 
Time Code Connections to Machines, Decks, 
and Other Devices” on page 12. 

Connecting SYNC I/O to a DigiSerial Port
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Serial Connections for SYNC I/O Setup 

 

SYNC I/O Setup requires a serial connection 
from SYNC I/O to a Macintosh or Windows 
computer. (For compatibility information, see 
“System Requirements” on page 2.)

 

To connect SYNC I/O to a Macintosh computer for 
SYNC I/O Setup without Pro Tools:

 

1  

 

Make sure the power is switched off for both 
SYNC I/O and the computer.

 

2  

 

Connect the SYNC I/O Host Serial port to the 
modem or printer port, or serial port adaptor, of 
your computer. 

 

3  

 

Restore power to SYNC I/O, and restart your 
computer. 

 

4  

 

Connect the rest of your equipment to 
SYNC I/O as described in “Synchronization and 
Time Code Connections to Machines, Decks, 
and Other Devices” on page 12. 

 

To connect SYNC I/O to a Windows computer for 
SYNC I/O Setup without Pro Tools:

 

1  

 

Purchase or make the required 9-pin to 8-pin 
cable. For wiring details, see “SYNC I/O Serial 
Cable Pin Assignments” on page 87. 

 

2  

 
Make sure all equipment is powered off. 

3  Connect the SYNC I/O Host Serial port to an 
available COM port on your computer. 

4  Restore power to SYNC I/O, and restart your 
computer. 

5  Connect the rest of your equipment to 
SYNC I/O as described in “Synchronization and 
Time Code Connections to Machines, Decks, 
and Other Devices” on page 12. 

SYNC I/O Setup will not control SYNC I/O 
through the Host Serial port.
Chapter 2: Installation and Getting Started 9
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Clock for 
Pro Tools Audio Interfaces

 

SYNC I/O must be connected to Pro Tools audio 
interfaces in the Loop Sync chain. 

 
Connecting Loop Sync for Pro Tools|HD

 (Pro Tools|HD Macintosh Only 

SYNC I/O now supports Loop Sync, and can 
serve as Loop Sync Master. Loop Sync is a dedi-
cated clock loop for synchronizing multiple HD-
series interfaces. Loop Sync should only be used 
to connect multiple HD-series peripherals.

The following steps explain how to make Loop 
Sync connections between the SYNC I/O and 
Pro Tools|HD interfaces. 

 

To connect SYNC I/O to Pro Tools|HD interface:

 

1  

 

Connect the Loop Sync Out of the SYNC I/O 
to the Loop Sync In of your primary HD-series 
audio interface. 

 

2  

 

Connect the SYNC I/O Loop Sync In to the 
Loop Sync Out of your HD-series interface. 

         

Loop Sync connections between SYNC I/O and a 96 I/O
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Loop SyncSYNC I/O

Pro Tools 96 I/O

  
SYNC I/O Guide
When using more than one HD-series audio in-
terface, make SYNC I/O the first and last unit in 
the Loop Sync chain. 

Using Legacy Audio Interfaces

To connect SYNC I/O to a Pro Tools|HD system 
that also has an 888|24, 882|20, 1622, or ADAT 
Bridge audio interface:

1  Connect SYNC I/O Loop Sync as described in 
the previous steps. 

2  Connect a BNC cable from the Ext Clock Out 
of your primary HD-series interface to the Slave 
Clock In of your first legacy audio interface. 

3  If using multiple legacy interfaces, daisy-chain 
their Slave Clock connections from the first in-
terface Slave Clock Out to the next interface 
Slave Clock In, and so on. 

Loop Sync in an expanded Pro Tools|HD system

Clock for SYNC I/O, a 96 I/O, and an 888|24 I/O

See the Getting Started with HD Guide for 
external clock configuration instructions.
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Connecting Slave Clock for 
Pro Tools|24 MIX and Pro Tools|24

 

To connect SYNC I/O to a Pro Tools|24 MIX-series 
or Pro Tools|24-series audio interface:

 

■

 

Using a BNC cable, connect the SYNC I/O 
Word Clock Out to the Slave Clock In of your 
primary audio interface. 

When Pro Tools launches, the SYNC I/O Word 
Clock Out port will switch to 256x Slave Clock 
output. In stand-alone use, you can manually 
configure the SYNC I/O for 256x Base clock out-
put using the front panel controls, or using 
SYNC I/O Setup software. See the 

 

SYNC I/O 
Guide

 

 for instructions. 

 

About the DigiSerial Port 

 

Pro Tools MIX and d24 cards feature a DigiSerial 
Port. Though this port is identical in appearance 
to the serial ports on your CPU, it is designed to 
only be used for: 

• the SYNC I/O Host Serial connection

• a USD Macintosh Serial connection 

• a serial to 9-pin cable in combination with the 
MachineControl™ option for Pro Tools 

             

Clock from SYNC I/O to an 888|24

 

The DigiSerial Port should not be used for 
MIDI Interfaces or any other serial device. 
Attempting to do so will adversely affect 
Pro Tools performance. 
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Selecting a DigiSerial Port for SYNC I/O in 
Expanded Systems

Always connect the SYNC I/O serial cable to the 
DigiSerial Port on the card connected to the pri-
mary Pro Tools audio interface (your MIX Core, 
“Core” d24, or MIX Farm if using an expanded 
Pro Tools|24 system).

9-Pin for MachineControl
SYNC I/O provides two 9-pin machine ports, to 
support direct 9-pin connection for Machine-
Control-enabled Pro Tools systems. Both ports 
can be connected simultaneously. In this con-
figuration, MachineControl and SYNC I/O pro-
vide all connections required for Serial modes, 
remote track arming, and other MachineCon-
trol features. See the MachineControl Guide for 
more information on all of its Pro Tools fea-
tures. 

To connect one or two machines for 
MachineControl Serial Control mode:

■ Connect a 9-pin cable from either SYNC I/O 
9-pin Out port to the 9-pin out of the machine. 
You can connect two machines, one to each 
port, and control either one of them at any 
time. 

Remote 9-pin Deck Emulation Mode

In order to use MachineControl Remote 9-pin 
Deck Emulation mode, you must connect a se-
rial-to-9pin cable to a standard Macintosh serial 
port or equivalent. For more information, see 
the MachineControl Guide. 
Chapter 2: Installation and Getting Started 11
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Synchronization and 
Time Code Connections to 
Machines, Decks, and Other 
Devices
The following sections describe connections re-
quired for different applications.

Connecting a Video Source

This section describes connections required 
when utilizing video and house video reference.

For SYNC I/O to resolve to house sync:

■ Connect the house video reference/black 
burst signal to the SYNC I/O Video Ref In port. 

This is a non-terminated loop-through connec-
tion. If the Video Ref connector is not used, 
then you must terminate it using the supplied 
75-ohm precision terminator resistor. 

For SYNC I/O to resolve directly to an incoming 
video signal:

1  Connect the video signal to the SYNC I/O 
Video In port. 

2  Terminate the SYNC I/O Video Out port, us-
ing the included BNC terminator. 

Character Generator for Window Burn

SYNC I/O can also generate a Window burn 
while using the same video source signal as the 
video reference. The following is one example 
setup for a window burn. 

To use the SYNC I/O Time Code Character 
Generator to make a window burn:

1  Connect your video signal to the SYNC I/O 
Video Ref In port.
SYNC I/O Guide
                    

2  

 

Use another BNC cable to connect the 
SYNC I/O Video Ref Thru port to the Video In 
port.

 

3  

 

Connect the SYNC I/O Video Out port to 
other video devices. 

 Connecting LTC  

SYNC I/O provides LTC input and output con-
nectors. 

 

To Input LTC to SYNC I/O:

 

■

 

Connect the LTC signal from your machine, 
synchronizer or other source to the SYNC I/O 
LTC In port. 

 

To output LTC from SYNC I/O:

 

■

 

Connect the SYNC I/O LTC Out to your exter-
nal device(s). 

 

Connecting Word Clock Devices

 

SYNC I/O has Word Clock input and output, 
and both can be used simultaneously. Use Word 
Clock when you want SYNC I/O to lock to 1x 
clock from DAT machines, DA-88s, and similar 
digital devices. 

Pro Tools|HD-series audio interfaces each pro-
vide their own Word Clock inputs, which pro-
vide additional clock options and flexibility. See 
your Pro Tools|HD documentation for more in-
formation. 

 

To input Word Clock to SYNC I/O:

 

■

 

Connect Word Clock from your master Word 
clock signal or device to the SYNC I/O Word 
Clock In. 



To supply Word Clock from SYNC I/O:

■ Connect the SYNC I/O Word Clock Out to the 
External Clock In of your HD audio interface; or, 
connect to the Word Clock input on any other 
compatible device. 

Make sure the SYNC I/O Word Clock Out port is 
configured for the appropriate choice (1x, or 
256x Slave Clock if using the SYNC I/O with 
Pro Tools|24 MIX or Pro Tools|24). 

Keep in mind that Word Clock contains no po-
sitional information; if you want devices to play 
or record in sync, you’ll still need to provide 
them with a positional reference. 

Connecting AES/EBU Devices

To use AES/EBU clock reference:

■ Connect the device’s AES/EBU output to the 
SYNC I/O’s AES/EBU input. 

To supply AES/EBU clock reference from 
SYNC I/O:

■ Connect the SYNC I/O AES/EBU output to the 
AES/EBU input on a DAT machine or other dig-
ital device. (AES/EBU clock does not support 
176.4 kHz or 192 kHz sample rates.) 

SYNC I/O can generate time code to provide 
positional reference to other devices. See 
“Generating & Regenerating Time Code” on 
page 45 for more information. 

Connecting SYNC I/O to an AES/EBU device
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Connecting MIDI 

 

The SYNC I/O MTC Out port supplies MIDI time 
code, derived from conversion (from LTC, VITC 
and Bi-Phase) or MTC generation, to synchro-
nize MTC-compatible consoles, sequencers, 
lighting systems and other devices. 

The MTC from the MTC Out always matches the 
time code address displayed on the SYNC I/O 
front panel. If you need to supply MTC from 
SYNC I/O to another MTC-compatible device, 
connect the device as described below. 

 

To connect an MTC-compatible device to receive 
MTC from SYNC I/O:

 

■

 

Connect the SYNC I/O MTC Out port to the 
appropriate MIDI input on the device using a 
standard MIDI cable. 

 

Pro Tools and MTC

 

Pro Tools does not receive MTC from SYNC I/O 
through its connection to the SYNC I/O Host 
Serial port. The signal does not include standard 
MIDI time code, but is instead a high-quality, 
proprietary time code signal designed for 
Pro Tools. Therefore, a MIDI Interface is not re-
quired.

 

OMS, Pro Tools, and SYNC I/O

(Macintosh Only)

 

When SYNC I/O is connected to the DigiSerial 
Port on an HD Core card, Pro Tools does not 
need any additional connections to facilitate 
MTC sync or communication (it is handled 
through the proprietary Mac Serial-to-DigiSerial 
Port or modem/printer port connection). 

  
Chapter 2: Installation and Getting Started 13
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Software Installation 
The following sections provide software installa-
tion instructions to install software required to 
use SYNC I/O with Pro Tools|HD, or with 
SYNC I/O Setup. 

Pro Tools|HD Systems

To install software to use SYNC I/O with 
Pro Tools|HD:

■ Make sure you have already installed the most 
current version of Pro Tools|HD software, and 
chosen the SYNC I/O custom options, from 
your Pro Tools Installer CD-ROM or the Digide-
sign Web site (www.Digidesign.com). 

Each release of Pro Tools|HD software also in-
cludes SYNC I/O firmware and documentation.

SYNC I/O Setup Software

When using SYNC I/O in stand-alone mode, the 
SYNC I/O Setup application is required in order 
to update firmware (as well as control all 
SYNC I/O parameters). Firmware updates are 
made available by Digidesign to add capabilities 
to your SYNC I/O. These updates can be down-
loaded from our Web site or obtained from your 
Digidesign dealer. 

To install SYNC I/O Setup:

1  Make sure SYNC I/O is connected to a serial or 
COM port of your computer, as described in “Se-
rial Connections for SYNC I/O Setup” on 
page 9. 

Pro Tools|24 MIX and Pro Tools|24 sys-
tems should use their most current version 
of Pro Tools software. 
SYNC I/O Guide
              

2  

 

Insert the disk containing the latest SYNC I/O 
software, or navigate to its location if you down-
loaded the update. 

3  Launch the installer and follow the on-screen 
instructions.

Getting Started with 
Pro Tools|HD and SYNC I/O
Pro Tools provides SYNC I/O initialization, con-
figuration, and firmware update controls. These 
establish communication between Pro Tools 
and SYNC I/O. 

This section describes how to configure 
Pro Tools for the SYNC I/O, how to check your 
configuration and firmware, and how to set ses-
sion settings relevant to the SYNC I/O. 

Loop Sync

SYNC I/O now supports Digidesign’s Loop Sync 
feature for connecting HD interfaces. SYNC I/O 
can be configured as the Clock Source (Loop 
Master), in order to provide Loop Sync master 
clock to the rest of your Pro Tools|HD hardware. 

In Pro Tools 5.3.1 Macintosh, many syn-
chronization controls have been moved to 
the Pro Tools Session Setup window. 

For system requirements and Loop Sync 
connection instructions, see Chapter 1, “In-
troduction.”



                
Auto ID of SYNC I/O through Loop Sync

Pro Tools|HD automatically recognizes if a 
SYNC I/O is connected to the DigiSerial port 
when Pro Tools is launched. When SYNC I/O is 
recognized, Pro Tools automatically configures 
the Device and Port settings for SYNC I/O on 
the DigiSerial Port in the Peripherals > Synchro-
nization dialog. Pro Tools also checks for recent 
firmware, and alerts you if you need to update 
the SYNC I/O. (See “Updating SYNC I/O Firm-
ware with Pro Tools|HD” on page 20 for more 
information.)

To check SYNC I/O and Pro Tools communication:

1  After installing Pro Tools and connecting the 
SYNC I/O as described, launch Pro Tools. 

2  Choose Setup > Peripherals, and click the Syn-
chronization tab. The SYNC I/O should be 
shown as the Device, with DigiSerial Port as the 
selected port. 

3  If these are not shown, check all your connec-
tions, then try manually selecting SYNC I/O and 
DigiSerial Port from the Device and Port selec-
tors. Once SYNC I/O is selected in this way, the 
SYNC I/O Setup controls become available in 
the lower part of the Peripherals window. 

4  Click Enable SYNC I/O Setup. Pro Tools scans 
the DigiSerial port and checks SYNC I/O firm-
ware. See “Updating SYNC I/O Firmware with 
Pro Tools|HD” on page 20 for more informa-
tion. 
Configuring Sessions for 
SYNC I/O in Session Setup

When connected through Loop Sync, and en-
abled in the Peripherals > Synchronization win-
dow, SYNC I/O settings become available in the 
Session Setup window. 

SYNC I/O enabled in Peripherals > Synchronization

Session Setup window, SYNC I/O controls

Clock Source

Frame
Rate 

Pull
Rates 

SYNC I/O controls and Status LEDs
Generate

VSO

Freewheel
Chapte
r 2: Installation and Getting
 Started 15



  

16

               
Clock Source

When connected and configured in the Loop 
Sync chain, SYNC I/O appears along with your 
HD-series audio interfaces in the Clock Source 
menu, located in the Session Setup window. 

Clock Source can be any device in the Loop Sync 
chain. This lets you utilize any digital input 
source available on any HD peripheral, includ-
ing the SYNC I/O, simply by selecting that de-
vice and source from the Clock Source menu. 

Clock Reference

The selected Clock Source device determines 
your choices for clock reference. 

When Clock Source is SYNC I/O

When the SYNC I/O is the Clock Source, it is the 
Loop Master. Clock and Positional Reference se-
lectors become active in the SYNC I/O Setup 
area of the Session Setup window. 

SYNC I/O selected as the current Clock Source in the 
Session Setup window

Selecting a 96 I/O option for Clock Source

SYNC I/O Setup and VSO controls in the Session Setup 
window

Clock Source

Positional ReferenceClock Reference

VSO
SYNC I/O Guide
SYNC I/O Clock Reference choices include In-
ternal/VSO, Video In, Video Reference, LTC, Bi-
Phase, Pilot, AES, and Word Clock. When the 
SYNC I/O is not the selected Clock Source de-
vice, the Clock Reference menu in the 
SYNC I/O Setup area switches to Loop Sync. 

To choose a SYNC I/O Clock Reference:

■ Select a SYNC I/O clock choice from the Clock 
Reference menu 

The Clock Source menu follows your selection 
of SYNC I/O for Clock reference, and automati-
cally switches to SYNC I/O. (You can also 
choose the SYNC I/O as Clock Source first, then 
select a Clock Reference.)

To choose a different Loop Sync device as Clock 
Source:

■ Choose a different Loop Sync device and 
Clock Source from the hierarchical Clock Source 
menu. 

For LTC clock reference, multiple choices 
are available from the LTC sub-menu. See 
“LTC and Clock Reference” on page 37 for 
more information.

SYNC I/O Clock Reference menu 

Clock Source menus in Session Setup



                       
When Clock Source is HD I/O

When a 96 I/O, 192 I/O, or 192 Digital I/O is 
providing the Clock Source, it will be the Loop 
Master. Clock Source options are available di-
rectly from the Clock Source menu, based on 
the configuration of that interface in the Hard-
ware Setup dialog. Choices can include AES, 
S/PDIF, Optical, or Word Clock.

Locked and Speed Cal LEDs

The Locked and Speed Cal LEDs are provided in 
the SYNC I/O area of the Session Setup window. 
These LEDs display synchronization status of 
the SYNC I/O, to reflect the state of the same 
LEDs on the front panel.

Locked The Locked LED stays lit when the 
SYNC I/O is locked to the selected clock refer-
ence. The Locked LED flashes if the selected 
clock reference source is missing or out of lock-
able frequency range. 

Speed Cal Speed Cal is meant to be used as an 
indicator of the accuracy of the incoming clock 
reference. The Speed Cal LED flashes when the 
output sample rate is not at the expected (or tar-
get) rate. Speed Cal stays lit when the output fre-
quency is within 200 ppm (0.02%) of the se-
lected sample rate. If the output frequency is 
higher than expected, Speed Cal will blink 
quickly; if it's lower, it will blink slowly. 

For example, if the session is 30 fps and LTC is 
the selected clock reference but the LTC is actu-
ally 29.97, the SYNC I/O will lock (the Locked 
LED will stay lit), but the Speed Cal LED will 
blink slowly. 

See the Getting Started with HD Guide for 
more information on audio interface config-
uration.

Locked and Speed Cal LEDs
Positional Reference

To select a positional reference:

1  Choose Window > Show Session Setup. 

2  Choose a positional reference from the Posi-
tional Reference menu, located in the 
SYNC I/O Setup controls. 

Sample Rate

The SYNC I/O sample rate is determined by the 
current Pro Tools session sample rate. In Stand-
alone mode, SYNC I/O sample rate can be se-
lected with SYNC I/O Setup software, or using 
the front panel switches. Current sample rate is 
indicated by the Sample Rate LEDs. 

When used with a Pro Tools|HD system, 
SYNC I/O supports all available sample rates. 
Setting the session rate in Playback Engine or 
Hardware Setup dialogs also sets the SYNC I/O 
to that sample rate. 

When using PostConform with the SYNC I/O, 
only 44.1 and 48 kHz sessions are supported. 

Audio and Video Pull Up and Pull Down 

(Macintosh Only)

Pro Tools 5.3.1 provides new 4.167% pull up, 
and 4.0% pull down choices. When working 
with a Movie track containing video, a separate 
Video Pull-Down menu becomes available in 
the Session Setup window, allowing you to ap-
ply standard or non-standard pull factors to au-
dio and video separately. This lets Pro Tools syn-
chronize to most supported SMPTE frame rates 
and formats. 

See the Pro Tools 5.3.1 Addendum for more 
information. 
Chapter 2: Installation and Getting Started 17



  

18

        
Frame Rate

While using Pro Tools, SYNC I/O frame rate au-
tomatically follows the session frame rate set-
ting. Session Frame Rate is set in the Session 
Setup window. 

To set the session Frame Rate:

■ Choose a rate from the Frame Rate selector in 
the Session Setup window. 

In Stand-alone mode, SYNC I/O frame rate can 
be set using the SYNC I/O Setup application, 
and from the front panel. 

PAL/NTSC Video Format Setting

Choose PAL or NTSC format for the session us-
ing the Video Format selector in the Session 
Setup window. See “PAL/NTSC Video Format 
Setting” on page 18 for more information. 

Choosing a session Frame Rate (Auto Match Pull 
Factors shown enabled)

Pro Tools provides additional frame rate 
settings, including audio and video pull up 
and pull down, as well as Auto Match Pull 
Factors. See the Pro Tools 5.3.1 Addendum 
for more information. 
SYNC I/O Guide
MachineControl Configuration
If using Digidesign MachineControl, do the fol-
lowing to establish basic communication. 

To configure MachineControl:

1  Choose Setup > Peripherals.

2  In the Synchronization window, make sure 
the SYNC I/O is the current Synchronization de-
vice, and DigiSerial is the selected port. 

3  Click the MachineControl tab to open the 
MachineControl window. 

4  Enable and configure options for 9-pin Serial 
or 9-pin Remote. SYNC I/O 9-Pin ports 1 and 2 
are available for Serial mode on HD systems 
only. (Remote mode requires a standard serial or 
COM connection.) 

Selecting Transport Master

The Pro Tools Transport window provides the 
Transport Master selector. This pop-up lets you 
select the device that will be controlled by the 
Pro Tools transport. Choices include Pro Tools 
and any other devices or modes you have en-
abled in the Synchronization or Machine Con-
trol tabs of the Peripherals dialog. 

See the MachineControl Guide for installa-
tion instructions and additional informa-
tion.

Transport master



Software Configuration for 
SYNC I/O Setup Software

To configure SYNC I/O Setup:

1  Make sure SYNC I/O is connected to your 
computer according to the instructions in “Se-
rial Connections” on page 8. 

2  Launch SYNC I/O Setup. 

3  Choose Preferences > SYNC I/O Setup Prefer-
ences.

4  If not already selected, choose the appropriate 
serial port for your SYNC I/O-to-CPU connec-
tion. 

5  Close the Preferences window. 
SYNC I/O Setup should now show that it recog-
nizes SYNC I/O in the information display area. 
If it does not, check your connections and port 
selection, and try again. 

For more information on firmware updates and 
SYNC I/O Setup, see “Updating SYNC I/O Firm-
ware” on page 20. 

Getting Started with 
Pro Tools|24 MIX and 
Pro Tools|24 
The SYNC I/O can be used with 
Pro Tools|24 MIX and Pro Tools|24 systems, as 
an alternative to the USD. When used with 
these system, the SYNC I/O emulates the USD. 

For instructions on how to connect a SYNC I/O 
to your MIX system, see “Hardware Connec-
tions” on page 7. 
To configure Pro Tools|24 MIX or Pro Tools|24 for 
a SYNC I/O:

1  Start up your system beginning with hard 
drives, then the SYNC I/O, then MIDI and other 
studio equipment, then the CPU. Turn on your 
speakers and monitoring system last. 

2  Launch Pro Tools. 

3  Choose Setups > Peripherals, and open the 
Synchronization tab. 

4  Select Universal Slave Driver for the Synchro-
nization Device. 

5  Select DigiSerial Port for the Port. 

6  Once the SYNC I/O is declared as a USD, click 
OK to close the Peripherals window. 

Using the SYNC I/O with Pro Tools|24 MIX and 
Pro Tools|24:

When used with Pro Tools 5.1.3, the SYNC I/O 
choices are labelled as USD options. This is be-
cause the SYNC I/O is able to emulate the USD, 
providing all of its supported features (the 
SYNC I/O only supports sample rates and other 
features as supported by the USD with 
Pro Tools|24 MIX and Pro Tools|24). 

To configure the SYNC I/O for your projects and 
sessions:

1  In the Session Setup window, select Clock and 
Positional References from their menus. 

2  To generate time code from the SYNC I/O, en-
able Generate using USD. 

3  Configure other settings as needed, selecting 
USD wherever appropriate. 
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Updating SYNC I/O Firmware
SYNC I/O contains a flash EEPROM that allows 
you to update the firmware in your unit at any 
time. As Digidesign continues to create im-
provements for SYNC I/O, you can update your 
unit without having to send it back to the fac-
tory or replace any chips. 

Pro Tools and SYNC I/O Setup can download 
up-to-date firmware to your SYNC I/O. 

Pro Tools|HD When Pro Tools 5.3.1 is installed, 
new firmware for the SYNC I/O will automati-
cally be installed in the SYNC I/O folder within 
the Digidesign folder. If there is no SYNC I/O 
folder in the Digidesign folder, the firmware will 
not be installed. To update your unit, launch 
Pro Tools and follow the instruction in the next 
section. You can also update firmware using the 
SYNC I/O Setup application.

Pro Tools|24 MIX and Pro Tools|24 Use the 
SYNC I/O Setup application to update SYNC I/O 
firmware. Updating SYNC I/O firmware 
through Pro Tools requires Pro Tools software 
version 5.3.1 or higher. 

Updating SYNC I/O Firmware with 
Pro Tools|HD

When you launch Pro Tools|HD, it checks your 
SYNC I/O firmware and compares it to the most 
recent version (see “Auto ID of SYNC I/O 
through Loop Sync” on page 15 for more infor-
mation). Pro Tools will compare firmware 
whenever you launch Pro Tools, or whenever 
SYNC I/O is enabled in the Peripherals > Syn-
chronization dialog. 

To acquire the latest firmware, please con-
tact Digidesign Customer Service, or visit 
the Digidesign Web site. 
SYNC I/O Guide
If Pro Tools determines that the SYNC I/O does 
not have the most current firmware, a dialog ap-
pears asking if you want to update it now. 

◆ Click Update to update your unit. This auto-
matically navigates to the firmware in the 
SYNC I/O folder and updates the SYNC I/O 
through the DigiSerial Port. 

– or –

◆ Press Cancel to quit Pro Tools without updat-
ing.

If for any reason the firmware file cannot be lo-
cated, Pro Tools will display a message indicat-
ing why (see “Firmware Messages” on page 20). 
If this happens, reinstall the Pro Tools software 
and repeat the firmware instructions. 

Firmware Messages

The following messages may appear during 
firmware updating:

Firmware Not Found If no compatible firmware 
is found in the SYNC I/O Folder, a dialog ap-
pears instructing you to install SYNC I/O firm-
ware. Use the Pro Tools installer CD, or use the 
latest version of SYNC I/O Setup.

SYNC I/O not on DigiSerial Port In order to up-
date SYNC I/O firmware from Pro Tools, 
SYNC I/O must be connected to the DigiSerial 
Port. Otherwise, if the SYNC I/O is connected to 
the CPU’s serial port, you can update the firm-
ware using SYNC I/O Setup. 

Follow the on-screen instructions very 
closely, being careful to power cycle your 
unit at the correct times during the process, 
as instructed.



Updating Firmware

To update SYNC I/O firmware from Pro Tools:

1  Choose Setups > Peripherals and click Syn-
chronization. 

2  Make sure you have already configured the 
Synchronization Device and Port options for 
SYNC I/O. 

3  Click Update SYNC I/O Firmware. 

4  Follow the instructions on-screen to complete 
the update.

SYNC I/O Setup Application and Firmware

If using the SYNC I/O with Pro Tools|24 MIX or 
Pro Tools|24, or if you are not using Pro Tools, 
use the most recent version of the SYNC I/O 
Setup application to install the latest version of 
firmware. SYNC I/O must be connected to a host 
computer serial port (SYNC I/O Setup is not sup-
ported through the DigiSerial Port.) The 
SYNC I/O firmware file will always be suffixed 
with “SYC.” 

To update SYNC I/O firmware using 
SYNC I/O Setup:

1  Make sure SYNC I/O is connected to the com-
puter as explained in “Serial Connections for 
SYNC I/O Setup” on page 9. 

2  Choose Preferences > SYNC I/O Preferences. 

SYNC I/O setup and firmware controls

Update firmware

Enable and
firmware version
3  Click Update SYNC I/O Firmware. 

4  Follow the instructions on-screen to complete 
the update. 

Troubleshooting

Status LEDs 

The status LEDs (LOCKED and SPEED CAL) on 
the SYNC I/O front panel and in the Session 
Setup window may help you isolate potential 
problems. 

Use the Current TC field in Pro Tools Session 
Setup Window as a Reference 

The Current TC field in the Session Setup Win-
dow indicates whether or not SYNC I/O is re-
ceiving positional reference. If this field appears 
to be inactive when inputting time code to 
SYNC I/O, check your hardware device settings, 
serial connection to your computer, and your 
software settings. 

Current Time Code display

Current TC
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Lost Communication

If Pro Tools loses communication with 
SYNC I/O, a dialog will appear asking you 
whether you want to switch to MTC (if avail-
able) or continue trying to locate SYNC I/O. If 
you see a “lost communication” dialog, check 
power, DigiSerial, and other connections. 

If you switched ports in order to update firm-
ware using SYNC I/O Setup, check to make sure 
you reconnected SYNC I/O to the Host Serial 
port on your HD Core card. 

Pro Tools|HD may present a dialog, which pro-
vides options for re-establishing synchroniza-
tion when communication with SYNC I/O 
stops: 

Use MTC Click this button if the SYNC I/O is un-
available, to switch to any currently connected 
MIDI interface for MTC synchronization. This 
option requires a compatible device that sup-
ports MTC conversion, and that is already con-
nected to your CPU and enabled. 

Keep SYNC I/O Click this to leave the session 
configured for SYNC I/O, or to continue search-
ing for the SYNC I/O to re-establish lost commu-
nication. 

Synchronization Accuracy

If you are noticing drift or lack of accurate syn-
chronization between your devices, check the 
following: 

◆ If your system locks up in the wrong place, 
make sure you have set the correct frame rate 
and format (NTSC or PAL) on all your devices. 

◆ If your system locks up in the correct location, 
but drifts, check your clock signals and settings. 
SYNC I/O Guide
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SYNC I/O Hardware and Software Overview
SYNC I/O Front Panel
Figure 1.  SYNC I/O Front Panel
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All SYNC I/O local controls are on its front 
panel; the back panel is reserved for connectors 
only. This section identifies each front panel 
switch and display. For information on back 
panel connectors and setup, see Chapter 2, “In-
stallation and Getting Started.”

AC Mains Power Switch

When in, SYNC I/O power is on; Out, power is 
off.

The LED ring around the power switch is orange 
while the SYNC I/O is powering up, or while 
firmware is being updated. When the SYNC I/O 
is ready for use after power cycling, or after up-
dating firmware, the power switch LEDs light 
green. 
Clock Reference Switch and LEDs

This switch selects the SYNC I/O clock refer-
ence, as indicated by the Clock Reference LEDs. 
Available clock reference inputs include Video 
Ref, Video In, LTC, Digital, Pilot, Bi-phase/Tach, 
Internal/VSO, and Loop Sync.

Loop Master Indicator

When lit, this LED indicates that the SYNC I/O 
is the current Pro Tools Loop Master device. 
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Sample Rate LEDs 

These green or yellow LEDs show the current 
SYNC I/O sample rate. Pull Up and Pull Down 
are available for all sample rate settings, indi-
cated by the appropriate PULL UP, or PULL 
DOWN LED. The table below shows the actual 
sample rates when pulled up or down by NTSC 
standard 0.1%. 

LED Displays and SYNC I/O Sample Rates 

Sample Rate 
LEDs

0.1% 
Pull Up

0.1% 
Pull 
Down

Actual 
Sample Rate 

44.1 kHz • 44.144 kHz

• 44.056 kHz

48 kHz • 48.048 kHZ

 • 47.952 kHz

88.2 kHz • 88.288 kHz

• 88.112 kHz

96 kHz • 96.096 kHz

 • 95.904 kHz

176.4 kHz • 176.576 kHz

• 176.224 kHz

192 kHz • 192.192 kHz

• 191.808 kHz

Pro Tools 5.3.1 and later support all the 
0.1% rates listed above, as well as 4.167% 
pull up, and 4.0% pull down (4% rates are 
not available in 176.4 and 192 kHz ses-
sions).
SYNC I/O Guide
Generator/Parameter Controls 

These four momentary switches provide direct 
access to many SYNC I/O functions, including 
time code generator settings, PAL/NTSC selec-
tion, sample rate and more. The Time Code LED 
display shows the current mode, selected pa-
rameter, or setting. 

Time Code Display

This 7-segment, multifunction LED is the 
SYNC I/O time code and parameter display. 

Time Code  The current positional reference (in-
ternal or external), is displayed in hours:min-
utes:seconds:frames. Odd/even field distinction 
is indicated using a decimal point to the right of 
the frames display. A lit decimal point to the 
right of frames indicates an even-numbered 
field; no decimal point indicates an odd-num-
bered field. When SYNC I/O is in Auto Switch 
LTC/VITC mode, the decimal point to the right 
of “minutes” illuminates.

Parameters and Values  When configuring 
SYNC I/O with the Set, Run/Stop and other pa-
rameter controls, the LED display shows param-
eter names, values, and other data.

For a table identifying each LED abbrevia-
tion and function, see “Parameters” on 
page 55. 



Positional Reference Switch

This switch selects the positional reference 
source, as indicated by the Positional Reference 
LEDs. Choices include LTC, VITC, Auto Switch 
Bi-phase, and Generate.

In Auto Switch LTC/VITC mode, both the LTC 
and VITC LEDs light while SYNC I/O deter-
mines which source it will use. Either the LTC or 
the VITC LED will remain lit to indicate the cho-
sen positional reference. 

Frame Rate Switch

This switch selects the time code frame rate and 
format (drop-frame or non drop-frame). The ac-
tive choice is displayed by the Frame Rate and 
DF (drop frame) LEDs. 

Frame Rate LEDs and DF Indicator

These display the current SYNC I/O frame rate: 
30, 29.97, 25, or 24 fps are indicated by four 
green LEDs. The DF LED indicates drop- or non-
drop. DF (a lit DF LED indicates drop frame, un-
lit indicates non-drop frame). 
Status LEDs

These LEDs show the current state of SYNC I/O 
in relation to clock references. Indicators in-
clude:

Locked This green LED lights solid when 
SYNC I/O is locked to the selected clock refer-
ence. LOCKED flashes if the selected clock refer-
ence source is missing or out of lockable fre-
quency range.

Speed Cal (Speed Calibration)  This yellow LED 
indicates when all output clocks are at a fre-
quency that corresponds with the chosen sam-
ple rate. Speed Cal flashes whenever there is a 
mismatch between the chosen sample rate and 
the actual output sample rate. Speed Cal com-
pares actual output sample rate to desired sam-
ple rate. This LED does not reflect the speed of 
motion of the chosen Positional Reference. 
However, it would bear a relationship to the Po-
sitional Reference if both Positional Reference 
and Clock Reference were set to LTC.

Remote Mode This green LED lights when 
SYNC I/O is set to Remote-Only /Front Panel 
Lockout mode. While this LED is lit, the front 
panel switches will have no affect on the 
SYNC I/O. (Do not confuse Remote-only/Front 
Panel lockout with Remote 9-pin Deck Emula-
tion mode.) For more information see the sec-
tion “Overview of SYNC I/O Setup” on page 28.
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SYNC I/O Back Panel 
SYNC I/O Guide
Figure 2.  SYNC I/O Back Panel
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In/Out

9-Pin Out 2
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Bi-Phase/Tach/GPI/Pilot

An accessory port for Bi-Phase, Tach, and Pilot 
signals (specific cables are required for different 
applications). This connector is also used for 
GPI input, output (including Fader Start), and 
thru signals. This port handles up to 12 volts Bi-
phase. 

Video Reference In/Out

Video Ref In  Receives a signal from an 
NTSC/PAL video source, such as a black burst 
(house sync) generator or a standard video sig-
nal, for clock reference and window burn pur-
poses. This jack is configured as an un-termi-
nated loop-through. Therefore, you must either: 

• Connect a 75-ohm terminator (included with 
SYNC I/O) to the Video Reference Out on the 
back panel, or 

• Ensure that another, terminated, video device 
is fed from the loop-through connector.

Video Reference Out A parallel, unbuffered con-
nection output for any video source connected 
to the Video Reference In port; allows black 
burst or other video reference to be passed to an-

Refer to Appendix C, “Wiring Diagrams 
Pin Assignments” for wiring information 
and other specifications for this port.
other device. Continues to output whatever sig-
nal is present at the Video Reference In port, re-
gardless of whether or not SYNC I/O is powered 
up. 

Host Serial Port

A bidirectional (in/out) port to connect 
SYNC I/O to the DigiSerial Port on a 
Pro Tools|HD Core card. When not being used 
with Pro Tools|HD, the SYNC I/O Host Serial 
port can be connected to a standard serial port 
on a supported host computer, for SYNC I/O 
Setup 

Video In/Out

Video In Receives a signal from an NTSC/PAL 
video source for clock or VITC positional refer-
ence input, or for generating a window burn. 
This connector is internally terminated at 
75 ohms. 

Video Out Output of the current Video In signal. 
If the Positional Reference is set to Generate and 
the Clock Reference is set to one of the two 
video inputs, this will output a copy of the video 

If SYNC I/O is the last device in the video 
sync chain, a BNC terminator (supplied) 
must be attached to this connector. 



signal appearing at the Video Reference input. 
In either case, this output might additionally 
carry VITC and/or Window Burn information if 
those features are enabled.

MTC Out

Outputs MIDI Time Code (MTC), only. No other 
MIDI data appears at this output. MTC output 
can be regenerated while SYNC I/O is locked to 
any supported positional reference and clock 
reference, or internally generated in Generate 
mode, in which case MTC output follows gener-
ator run/stop. This port is intended to supply 
MTC from SYNC I/O to external sequencers or 
other MIDI devices. 

LTC In/Out

LTC In Receives a Linear Time Code (LTC) 
source, balanced or unbalanced analog, for 
clock and positional reference. This port is often 
used to receive LTC from an audio track on an 
external deck or the address track of a VTR. Ad-
justable LTC servo gain is available in Pro Tools 
and from the front panel. 

LTC Out Outputs linear time code, in balanced 
or unbalanced analog audio format. See 
Appendix C, “Wiring Diagrams Pin Assign-
ments” for wiring details. LTC output gain is 
also adjustable from the front panel and from 
the SYNC I/O Setup software. 

AES/EBU In/Out

AES In Receives an AES/EBU digital audio signal, 
for clock reference purposes only. SYNC I/O uti-
lizes only the signal's clock information, not the 
audio information. If digital audio information 
is present at this input, it will be ignored and 
not passed through to the AES/EBU digital out-
put connector. 
AES/EBU Out Outputs a silent (all bits OFF) 
AES/EBU audio signal whose sample rate exactly 
matches SYNC I/O Word Clock BNC output.

Word Clock In/Out

Word Clock In Receives (1x sample rate) Word 
Clock, for clock reference purposes only. Word 
Clock is often used with external digital con-
soles and digital tape machines. 

Word Clock Out Outputs 1x sample rate Word 
Clock information, or 256x Slave Clock, to pro-
vide clock to HD-series audio interfaces, Legacy 
peripherals, and other Word clock-capable de-
vices. This port is configured from the front 
panel, or using SYNC I/O Setup, by adjusting 
the SYNC I/O Base Clock setting. 

9-pin Out 1 and 2

For Digidesign MachineControl-enabled sys-
tems, these two ports connect directly to exter-
nal 9-pin transport devices. See the Machine-
Control Guide for more information. 

Loop Sync In/Out

Loop Sync is the clock signal used to synchro-
nize Pro Tools|HD-series audio interfaces. 

Loop Sync In Receives Loop Sync from any HD-
series audio interface. 

Loop Sync Out Provides Loop Sync. This port 
connects to the primary HD-series audio inter-
face. 

AC Power In

Receives AC mains power, 85 to 264 volts, 47 to 
63 Hz (auto switching). 
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SYNC I/O Setup Software 
The following is an overview of SYNC I/O Setup. 
System and installation requirements for 
SYNC I/O Setup can be found in “Software In-
stallation” on page 14.

Using Help 

To activate Help:

■ Choose Help > Show Help, or click on the 
question mark button in the upper-right corner 
of the SYNC I/O Setup window. 

To deactivate Help:

■ Choose Help > Hide Help, or click the ques-
tion mark button again.

Overview of SYNC I/O Setup 

The following section identifies SYNC I/O Setup 
controls and displays. 

SYNC I/O Setup 
SYNC I/O Guide
Time Code Window

The time code display mirrors the LED Time 
Code Display on the SYNC I/O front panel, dis-
playing (in hours:minutes:seconds:frames) the 
time code address of the current positional ref-
erence.

When SYNC I/O is reading odd-numbered 
fields, the separator changes from a normal co-
lon (:) to a period (.); when it’s reading even-
numbered fields, the punctuation returns to a 
colon (:). Odd/even status is only available 
while reading VITC, and only when VITC is 
within a speed range from zero to about 50% of 
playback speed.

Clock Reference

Selects SYNC I/O clock reference. 

Sample Rate

Selects SYNC I/O sample rate (or the Pro Tools 
session sample rate, if applicable).

Pull Rate

Enables Pull Up or Pull Down for the current 
sample rate. 

User Sync Out 

Configures the base clock of the External Clock 
Output for 1x (session sample rate) or 256x (for 
Slave Clock devices only). 

Word Clock Out

Configures the SYNC I/O Word Clock Output 
between 256x (Super Clock) and the current ses-
sion rate (1x at 44.1 kHz, or 1x at 48 kHz). Only 
Legacy audio interface require 256x Super 
Clock.



Positional Reference

Selects SYNC I/O positional reference.

Frame Rate

Selects the frames-per-second (fps) rate of exter-
nal (or internally generated) time code.

Status 

Shows the current state of SYNC I/O Setup soft-
ware in relation to SYNC I/O and external de-
vices, as follows:

Resolver Locked Lights when SYNC I/O is 
locked to the chosen external clock reference, or 
to its Internal clock reference. 

Speed Calibration  Lights when SYNC I/O sys-
tem clock and all output clocks are at a fre-
quency that corresponds with the chosen sam-
ple rate. Capable of indicating mismatch of pull-
up, pull-down and frame rate. 

Generator Running Lights when SYNC I/O is re-
generating time code at its video, LTC, and MTC 
outputs locked with the incoming positional 
reference source. Also lit whenever SYNC I/O is 
generating time code internally.

Connected to SYNC I/O Lights when SYNC I/O 
Setup is the front-most window and is commu-
nicating with SYNC I/O. 

Waiting for SYNC I/O  Lights when SYNC I/O 
Setup is the front-most window and is unable to 
communicate with SYNC I/O.

Port Relinquished  Lights when SYNC I/O Setup 
is not the front-most window or is unable to al-
locate a serial port with which to communicate 
with SYNC I/O. 

For details about Speed Calibration charac-
teristics, see “Status LEDs” on page 25. 
LTC Output Level

Adjusts the analog audio level of the SYNC I/O 
LTC output, from –24 dBu to +9 dBu.

Freewheel Duration

Sets the period of time for which SYNC I/O will 
continue to supply positional reference data af-
ter an external source is interrupted or stopped 
(also referred to as Time Code Freewheel in 
Pro Tools).

Video Format

Selects the format (NTSC or PAL) for both the in-
coming and outgoing video signals. 

◆ NTSC is used in North and South America, Ja-
pan, and certain other parts of the world. 

◆ PAL is used in most of Europe, Asia, and Af-
rica. Users of SECAM video (for France, Russia, 
and certain other parts of the world) should se-
lect PAL. 

VITC Read Lines

Determines which line pair of incoming video 
signal is used for the VITC source. When set to 
Auto, SYNC I/O will search for the first valid line 
pair automatically. Alternatively, this value can 
be set to specific VITC line pairs.

VITC Generate Lines

Determines the line pair of the outgoing video 
signal onto which SYNC I/O inserts VITC. Nor-
mally, this should be left at the default (and pre-
ferred) setting of 14/16. 
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VITC Insertion Enabled

When selected, VITC will be inserted into the 
outgoing video signal—assuming that a video 
signal is present at a SYNC I/O video input, and 
that SYNC I/O is in a valid mode for inserting 
VITC. The only invalid positional reference 
modes are VITC or Auto Switch LTC/VITC. 
SYNC I/O can’t read VITC and generate new 
VITC at the same time.

Pitch Memory Enabled

When selected, SYNC I/O will remain at a pitch 
(sample rate) that corresponds to the last known 
incoming time code speed. When deselected, 
SYNC I/O will revert to the selected sample rate. 
If Pitch Memory is disabled and the selected ex-
ternal clock reference is not available, then 
SYNC I/O will revert to the nominal, selected in-
ternal sample rate setting.

Idle MTC Enabled

Controls MTC Output during idle (play 
stopped). When enabled, MTC is continuously 
output. When not enabled, MTC output is 
muted when playback is idle. See “MTC Idle 
Mute” on page 59 for details. 

Window Dub

Settings for SYNC I/O character generator/win-
dow dubbing features. (These controls are also 
available from within the Pro Tools Peripherals 
dialog.) Complete Window Dub instructions are 
provided in the section “Generating a Window 
Burn” on page 51. 
SYNC I/O Guide
Bi-Phase/Tach Parameters

Used for specialized applications that involve 
film or other equipment that output Bi-
Phase/Tach information. These parameters 
must be set to match the Bi-Phase or Tach source 
to achieve lock. 

Generator/Bi-Phase Preset

Serves two functions, as determined by the cur-
rent SYNC I/O mode:

Generate Mode  Sets the time code start time di-
rectly by clicking in the Hrs:Min:Sec:Frm fields 
and typing in a value. The Tab key will cycle 
though the fields. 

Bi-Phase/Tach Mode Zeros the time code 
counter, to allow SYNC I/O to generate time 
code in relation to the pulses of the incoming 
Bi-Phase/Tach information. Establishes a time 
code start point (first frame of a reel, for exam-
ple). 

Variable Speed Override (VSO)

Used to varispeed the rate of SYNC I/O internal 
crystal-referenced clock (±699 cents; a cent is 
one-hundredth of a semitone). VSO is available 
at any positional reference setting, but only 
when the clock reference is Internal/VSO. 
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Using Sync I/O
SYNC I/O settings can be controlled in three 
ways: 

• from Pro Tools

• using the front panel controls

• using SYNC I/O Setup

Pro Tools Most SYNC I/O controls are available 
within Pro Tools and from the front panel. 

Stand-alone  Remote installations (stand-alone) 
use the SYNC I/O front panel switches and dis-
plays. 

SYNC I/O Setup Optional software remote con-
trol from a supported Macintosh or Windows 
computer, SYNC I/O Setup provides access to all 
SYNC I/O parameters. 

For a listing of SYNC I/O parameters supported 
in each method, see “SYNC I/O Controls in 
Pro Tools, SYNC I/O Setup and the Front Panel” 
on page 32. 
About SYNC I/O Setup Remote-Only 
Mode 

When the default Remote-Only Mode (Front 
Panel Lockout) is enabled in the SYNC I/O Setup 
Preferences window, none of the SYNC I/O 
front panel switches will be operational. The Re-
mote Only LED will be lit.

To exit Remote-Only mode from the front panel:

■ Simultaneously press and hold down the 
Clock Reference, Positional Reference, and 
Frame Rate front panel switches.

This will disengage SYNC I/O from Remote-
Only mode. This is useful when the host com-
puter is not easily accessible to override Remote-
Only Mode.

Pro Tools SYNC I/O controls always provide 
access to most SYNC I/O parameters.
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SYNC I/O Controls in Pro Tools, SYNC I/O Setup and the 
Front Panel
SYNC I/O Controls in Pro Tools, SYNC I/O Setup, and the Fr
SYNC I/O Guide
ont Panel
Available from/in:

Parameters Pro Tools Front Panel SYNC I/O Setup

Firmware Update yes (Peripherals/Sync) no yes

Clock References all (Session Setup) all all

Positional References all (Session Setup) all all

Sample Rates all all all

Pull Rates yes yes yes

Base Clock 
(External Clock Out)

no yes yes

Frame Rates all (Session Setup) all all

LTC Output level no yes yes

LTC Servo gain no yes no

Freewheel duration yes (Session Setup) yes yes

Video Format 
(NTSC/PAL)

no yes yes

VITC Read Lines no yes yes

VITC Generate Lines no yes yes

VITC Insertion Enable no yes yes

Pitch Memory no yes yes

Window Dub all (Peripherals/Sync) on/off only yes, all

Bi-Phase/Tach no yes yes

Gen/Bi-Phase Preset Generator, no Bi-Phase yes yes

GPI yes no no

VSO yes (Session Setup) no yes

Idle MTC Enabled no yes yes

USD Emulation mode no yes n/a



Using the Front Panel 
Generator/Parameter 
Switches
The Generator/Parameter Controls are labelled 
SET, DOWN, UP, and RUN/STOP/CLEAR. In ad-
dition to their primary generator functions, 
these switches provide front panel access to 
most SYNC I/O parameters. 

Features Not Accessible from the SYNC I/O 
Front Panel Controls

The front panel provides access to all SYNC I/O 
features except the following (which can be con-
trolled using Pro Tools or SYNC I/O Setup): 

• Remote-Only Mode/Front Panel Lockout

• Firmware update

• Changing Window Burn Size, Vertical Posi-
tion, Horizontal Position, and Color

• GPI (General Purpose Interface) functions

• Variable Speed Offset (VSO) 

For a listing of available parameters, refer to 
Table  on page 32.

Set

The SET switch has three primary functions:

When time code is displayed  Pressing Set once 
changes the Display from time code to parame-
ter names. 

Generator/Parameter Switches

DF

SET DOWN UP RUN/STOP
CLEAR

LTC

VITC

BI-PHASE

GENERATE

POSITIONAL
REFERENCE
When a parameter name is visible  Pressing Set 
once will change the Display to show parameter 
values. 

When a parameter value is visible  Pressing Set 
once will set that parameter value, and will re-
turn the Display to time code. 

Down and Up

These switches scroll through parameter names 
and values (whichever is currently displayed):

When a parameter name is visible  Pushing the 
Down and Up switches scrolls through the pa-
rameter names (for example, from SET GEn to 
VIdEo SY). 

When a parameter value is visible  These 
switches scroll through the available parameter 
values. 

When entering time code values  Pressing these 
two switches simultaneously tabs through the 
hours:minutes:seconds:frames fields. 

Run/Stop/Clear

This switch has two functions, depending upon 
the current mode:

While generating time code  Pressing RUN/STOP 
starts or stops the time code generator when 
SYNC I/O is in Generator Preset mode. 

While time code is being displayed  Clear resets 
the counter whenever time code is visible in the 
LED Time Code display. 

Otherwise, the RUN/STOP+CLEAR switch serves 
as a Cancel button (Clear mode). 
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Edit Mode

To enter Parameter/Value Edit mode:

■ Push Set (when time code numbers are visible 
in the LED Time Code Display). One press will 
display the first parameter name, “Set Gen,” (for 
the time code generator:)

A different parameter may be displayed, de-
pending on any previous adjusting of Genera-
tor/Parameter controls. 

To scroll parameter choices:

■ Press Up or Down as needed to scroll through 
available parameters. Holding the switch scrolls 
through the parameters.

To select a parameter to edit:

■ When the desired parameter is displayed, 
press Set. This will access that parameter’s cur-
rent setting.

To edit parameter values:

■ With parameter values displayed, press Up or 
Down to cycle through the available values. 

The (default) first page of Generator Parameter controls 
SYNC I/O Guide
Example: Using Set, Down and Up to adjust 
LTC Gain

As an example, the following steps explain us-
ing the SYNC I/O front panel controls to change 
the Linear Time Code output level. LTC Gain is 
the example parameter, but the basic steps are 
similar for most parameters. 

To select parameters for editing:

1  Press Set until the LED Time Code Display 
shows a parameter name. The first name is Set 
Generator (SE7 6En), although you may see a 
different name, depending upon the SYNC I/O 
last settings. 

2  Press the Down or Up switches until the LED 
Time Code Display shows LTC Gain (L7C 6AIn). 

3  Press the Set switch again. The LED Time Code 
Display will now show the current parameter 
value for LTC Gain in dBu values.

4  Press the Down or Up switches to scroll 
through the available parameter options. Values 
will scroll (in 3 dBu steps). Hold down either 
Down or Up to fast-scroll. 

5  When the desired parameter value is dis-
played, press the Set switch again. 

With just a few exceptions these steps remain 
the same for all SYNC I/O parameters. 

For a complete listing of all the front panel 
Generator/Parameter controls, see 
Chapter 5, “Additional Operational Infor-
mation.”



Clock References and Options
The following sections provide specialized in-
structions for each clock reference choice. For 
basic instructions to choose the clock or posi-
tional reference, set frame rate, or set SYNC I/O 
sample rate, see Chapter 2, “Installation and 
Getting Started.”

Video Clock Options

SYNC I/O provides two video inputs, Video Ref 
In and Video In, which are each selectable for 
clock reference. See “Video and Clock Refer-
ence” on page 35).

For House Video Reference (Black Burst) Use the 
SYNC I/O Video Ref Input. 

For Incoming Video  Use the Video In connector. 

Serial Time Code with MachineControl

MachineControl-equipped Pro Tools systems 
can utilize serial time code through either of the 
SYNC I/O 9-pin ports. When using Machine-
Control with serial time code as the positional 
reference, SYNC I/O must be locked to Video 
Ref. In this scenario, SYNC I/O is set to Generate 
mode to indicate that positional information is 
acquired by Pro Tools directly over the 9-pin ca-
ble, not through SYNC I/O. Consult the Machi-
neControl User’s Guide for complete serial time 
code information. 

MachineControl also provides Remote 
mode, but this mode is not supported 
through either of the SYNC I/O 9-pin ports. 
See Appendix D, “MachineControl and 
SYNC I/O” for more information. 
Video and Clock Reference

If you have only a single video source, and since 
SYNC I/O uses different video inputs depending 
on configuration, you may want to follow the 
wiring tip below to ensure that you have full 
functionality in all configurations:

To work with a single video source:

1  Connect the video signal to Video Ref In.

2  Run a short BNC jumper cable from the Video 
Ref Thru connector to the Video In connector.

3  Connect the Video Out signal to the video in-
put of your “destination” VTR or video editing 
system.

The issue of which video connector is used also 
matters when choosing a positional reference. 
For instance, when SYNC I/O is in Generate 
mode and Video is the current clock reference, 
the time code reference for the generator is al-
ways from the Video Ref In connector. 

However, if you select a positional reference 
other than Generate, then the signal at the 
Video In connector is used. 

For more video signal information, refer to 
“Video and VITC Signals” on page 65 in 
Appendix A. 
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Digital Clock

To resolve Pro Tools/SYNC I/O to external 
AES/EBU, Word Clock or SuperClock:

From Pro Tools

■ Select the appropriate digital clock reference 
from the Clock Reference pop-up in the 
Pro Tools Session Setup window.

Using the front panel controls

1  Press the front panel Clock Reference switch 
to select Digital as the clock reference. 

2  Press Set. 

3  Press Up or Down until Digital Reference (dI6 
rEF) is displayed in the LED. 

4  Press Set again. The LED Time Code Display 
displays the current digital reference, which will 
be:

• AES/EBU (AES-E8U), or

• Word Clock (I CLOC) 

5  Use Down and Up to select the desired digital 
clock.

6  When the desired option is shown, press Set. 

Using SYNC I/O Setup 

■ Select the appropriate Digital clock reference 
option from the Clock Ref pop-up menu.

If the chosen clock reference source is unavail-
able, or the current configuration is not valid, 
the Locked LED on the far-right of SYNC I/O 
front panel will flash.
SYNC I/O Guide
Additional Digital Clock Information

AES/EBU  The SYNC I/O AES In connector only 
recognizes and uses the clock portion of an in-
coming AES/EBU audio signal. All audio infor-
mation will be ignored and will not be passed to 
the SYNC I/O AES Out connector.

Word Clock Word Clock is a digital clock refer-
ence signal that runs at 1x sample rate (44.1, 48, 
88.2, 96, 176.4, or 192 kHz). Pro Tools|HD-series 
audio interfaces have dedicated BNC-style Word 
Clock connectors. A wide variety of professional 
audio devices have Word Clock connectors, in-
cluding digital mixing consoles, DASH-standard 
digital multitrack tape recorders and MDMs 
(modular, digital multitrack recorders).

Slave Clock (256x) 

Slave Clock (or Super Clock) is a Digidesign pro-
prietary hi-speed clock used by legacy Digide-
sign audio interfaces that run at 256x the sam-
ple rate. Slave Clock is utilized when using 
Digidesign Pro Tools 888|24, 882|20, 1622, and 
ADAT Bridge audio interfaces. When using leg-
acy peripherals with SYNC I/O and 
Pro Tools|HD, your master HD audio interface 
(96 I/O or 192 I/O) should supply Slave Clock to 
the first legacy device through its External Clock 
Out connector, configured for 256x Slave Clock 
(see “Base Clock” on page 56 for more informa-
tion). 

Pro Tools|HD-series audio interfaces are always 
connected using Loop Sync (see “Clock for 
Pro Tools Audio Interfaces” on page 10 for more 
information). 

For additional digital clock signal informa-
tion, see “Digital Clock Signal Types” on 
page 67. 



LTC and Clock Reference

LTC can provide both positional and clock in-
formation as part of the time code signal. LTC 
cannot be read when the reference deck is 
stopped or playing back at slow speeds, or at fast 
wind speeds (roughly 10x playback speed).

While resolving to LTC clock, the SYNC I/O 
now provides five options to optimize your sys-
tem for different types of tasks. This lets you 
choose between quickest response (for when 
fast lock-up time is critical), or highest sound 
quality (during critical laybacks, for example). 

The Session Setup window provides a sub-menu 
for LTC Clock Reference choices. The five 
choices provide different servo gain settings to 
reduce the effects of jitter when locking to linear 
time code. In Stand-alone mode, these settings 
are also available from the front panel.

To choose an LTC setting:

■ Choose a setting from the hierarchical LTC 
Clock Reference menu: Choices include:

LTC 0 (fastest) Allows the quickest resolving to 
incoming LTC, but with greater jitter. This is the 
default setting, and should be used when fast 
lock ups are critical.

LTC 1 Provides a next to fastest setting.

LTC 2 (average) Offers a compromise of lock up 
time and jitter quality.

LTC 3 Provides a next to slowest setting.

Clock Reference > LTC menus in Session Setup 
LTC 4 (smoothest)  Offers the lowest jitter from 
LTC resolve, but can take six to ten seconds to 
achieve full resolve. This setting is most appro-
priate when loading critical audio from an ana-
log master, where reducing or eliminating jitter 
is more important than lock speed. Be sure to al-
low adequate pre-roll before punching in. 

Using the front panel controls:

1  Using the Set, Down, and Up switches, select 
LTC Servo Gain (SErVo Gn). 

2  Use the Up and Down switches to select a gain 
setting. 

3  Using the Clock Reference switch, select LTC 
as the clock reference. 

Using SYNC I/O Setup:

■ Select Linear Time Code (LTC) from the 
SYNC I/O Setup Clock Ref pop-up menu.

Additional LTC Information

LTC can provide positional and clock reference. 
LTC can be recorded onto and played back from 
an analog track, or a VTR audio, address or cue 
track. 

SYNC I/O provides adjustable LTC servo 
gain. See “Servo Gain” on page 58.

For further information on LTC signals, see 
“LTC Signals” on page 66. 
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Pilot Tone

SYNC I/O can resolve to an external Pilot Tone 
signal for clock reference, for synchronizing to 
(or transferring audio from) certain types of 
open-reel audio tape recorders. Pilot Tone is ba-
sically a 60 Hz (NTSC) or 50 Hz (PAL) sine wave 
tone. Pilot Tone is used on location film shoots 
to establish a common sync reference between a 
film or video camera with a portable 1/4” analog 
ATR. Pilot Tone contains no positional informa-
tion; it provides only clock reference. 

SYNC I/O decides whether to use 60 Hz or 50 Hz 
as the pilot tone reference frequency according 
to the setting of the Video Format. When set to 
PAL, the pilot tone frequency is assumed to be 
50 Hz. When set to NTSC, 60 Hz is assumed.

To resolve SYNC I/O to Pilot Tone:

From Pro Tools:

■ In the SYNC I/O Setup area of the Pro Tools 
Session Setup window, click on the Clock Refer-
ence pop-up and choose Pilot Tone.

Using the front panel controls:

1  Connect your Pilot Tone reference source to 
the SYNC I/O Bi-Phase/Tach/GPI/Pilot port.

2  Using the front panel Clock Reference switch, 
select Pilot. 

Using SYNC I/O Setup:

1  Connect your Pilot Tone reference source to 
the SYNC I/O Bi-Phase/Tach/GPI/Pilot port. 

2  Select Pilot Tone under the SYNC I/O Setup’s 
Clock Ref pop-up menu.

For additional Pilot Tone information, see 
“Pilot Tone” on page 69 in Appendix A.
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Bi-Phase/Tach and Clock Reference

SYNC I/O is able to resolve to Bi-Phase/Tach in-
formation for use as a clock reference. Bi-
Phase/Tach can synthesize positional reference, 
but you must provide a reference start address 
(see “Bi-Phase Position Trimming” on page 45 
for other requirements). 

To configure Bi-Phase/Tach for SYNC I/O clock 
reference: 

Using SYNC I/O Setup:

1  Select Bi-Phase/Tach under SYNC I/O Setup’s 
Clock Ref pop-up menu.

2  Select the appropriate Pulse Per Frame and In-
put Signals parameters, as described in “Bi-
Phase/Tach Starting Frame” on page 44 and “Bi-
Phase/Tach Signal” on page 44. 

Typically, when you use Bi-Phase/Tach as the 
clock reference you will also be using it as the 
positional reference (see “Bi-Phase/Tach Posi-
tional Reference” on page 43.). 

Using the front panel controls:

1  Using the front panel Clock Reference switch, 
select BI PHASE/TACH. 

2  Select the appropriate Pulse Per Frame and In-
put Signals parameters, as described in “Bi-
Phase/Tach Starting Frame” on page 44 and “Bi-
Phase/Tach Signal” on page 44. 

If the Bi-Phase/Tach reference clock source 
is not valid for any reason (such as a poor 
connection or other signal transmission 
problem), the Locked LED on the far-right 
of the SYNC I/O front panel will flash. 
SYNC I/O accepts up to 12 volts at the Bi-
Phase input. 



To select Bi-Phase/Tach as the positional 
reference from Pro Tools:

■ In the SYNC I/O Setup area of Pro Tools Ses-
sion Setup window, click on the Clock Reference 
pop-up and select Bi-Phase. 

Internal Clock, Generating and 
Regenerating

SYNC I/O can use its own, crystal-referenced, in-
ternal clock as a master clock source. When 
SYNC I/O Clock Reference is set to Internal:

• Word clock and AES/EBU digital clock outputs 
are simultaneously driven from the internal 
crystal reference.

– and –

• If the Positional Reference is set to Generate, 
generated LTC, MTC, VITC count, and Win-
dow Dub outputs are resolved to the the same 
internal crystal reference.

To resolve SYNC I/O to its internal clock:

From Pro Tools

■ In the SYNC I/O Setup area of Pro Tools Ses-
sion Setup window, select Internal from the 
Clock Reference selector.

Using the front panel controls

■ Use the front panel Clock Reference switch to 
select Internal. 

Using SYNC I/O Setup

■ Select Internal/VSO from the SYNC I/O Setup 
Clock Ref pop-up menu. 

For additional Bi-Phase/Tach signal infor-
mation, see “Bi-Phase/Tach” on page 68 in 
Appendix A. 
Variable Speed Override (VSO)

You can varispeed the rate of SYNC I/O’s crystal-
referenced internal clock, to fine-tune the speed 
and subsequent pitch of Pro Tools and any de-
vice receiving its clock reference from 
SYNC I/O.

VSO is available at any positional reference set-
ting. VSO is not available from the front panel 
controls, but can be controlled directly from Pro 
Tools and SYNC I/O Setup. 

To varispeed the rate of SYNC I/O’s internal clock:

Using Pro Tools

1  Choose Windows > Session Setup, and expand 
the Session Setup window to full view. 

2  Click to enable VSO. 

3  Adjust the varispeed value using the on screen 
slider.

Using SYNC I/O Setup

1  In the SYNC I/O Setup’s Variable Speed Over-
ride section, check the VSO Enabled box. An 
“X” indicates that varispeeding is enabled.

The Variable Speed Override section
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2  Use the sliders to adjust the varispeed values 
in semitone or cent increments. The actual out-
put word-clock frequency is shown near the 
sliders. 

– or –

Enter the value in semitones and cents using the 
editable fields. Varispeed range changes with 
sample rate, as shown in the following table. 

SYNC I/O will only output rates within the lim-
its of the current sample rate. If a varispeed 
value results in an output frequency (sample 
rate) that is below or above the limits for the 
current sample rate, the frequency display turns 
red. 

3  When finished, click Set.

Effective VSO rates

Sample Rate 
(kHz)

Rate 
Type

Min 
(kHz) 

Max 
(kHz)

44.1 1x 40000 50500

48

88.2 2x 80000 101000

96

176.4 4x 160000 202000

192
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Using Pitch Memory

Pitch Memory holds the output sample rate 
steady even when the Clock Reference has dis-
appeared or gone out of lock range. If not en-
abled, the output sample rate will return to the 
nominal rate (for example, exactly 44.1 kHz) 
when the Clock Reference disappears or goes 
out of lock range.

With Pitch Memory enabled, Pro Tools contin-
ues to play and record at the resolved sample 
rate even if the Clock Reference source disap-
pears. If Pitch Memory is disabled and the se-
lected external clock reference is not available, 
SYNC I/O will revert to the nominal, selected in-
ternal sample rate setting. 

To configure Pitch Memory from the front panel:

1  Using Set, Down, and Up, select Pitch Hold 
(PICH HLd).

2  Press Set again. The LED Time Code Display 
shows On or Off.

3  Use Down and Up to switch between the pa-
rameter values. 

Using SYNC I/O Setup:

■ Click Pitch Memory Enabled. 

When you have chosen your desired option, 
press Set. The LED Time Code Display will re-
turn to showing time code numbers. SYNC I/O 
will retain the setting, even when the unit is 
powered off and on again, until changed



Positional Reference 
and Options
The following sections provide additional infor-
mation for each available Positional Reference 
format. 

Linear Time Code (LTC) 

LTC is often striped onto an ATR or VTR audio 
track. Professional VTRs typically have an ad-
dress or cue track, intended for LTC. If you are 
working with a standard audio tape, you’ll al-
most certainly be working with LTC; if you’re 
working with a videotape, you may be able to 
work with either LTC or VITC, or both. 

LTC can also be generated as an interpolation of 
Absolute code. This is how time code DAT ma-
chines, DA-88, and many digital VTRs work. In 
any case, LTC is delivered to SYNC I/O as a series 
of audio pulses, regardless of how it is stored or 
generated.

LTC can function simultaneously as a positional 
reference and a clock reference. 

To use LTC as SYNC I/O’s positional reference:

From Pro Tools:

■ In the SYNC I/O Setup area of the Session 
Setup window, choose LTC from the Positional 
Ref pop.

Using the front panel controls:

■ Using the front panel Positional Reference 
switch, select LTC. 
Using SYNC I/O Setup:

■ Select Linear Time Code (LTC) under 
SYNC I/O Setup’s Positional Ref pop-up menu.

Ensure that you’ve selected the appropriate 
clock reference, sample rate, frame rate, and 
freewheel duration. Also make sure the LTC sig-
nal is routed properly to SYNC I/O LTC In con-
nector. 

Freewheel Duration

Freewheel duration (time code freewheel) con-
figures SYNC I/O for a maximum number of 
frames it should continue generating if time 
code drops out or is otherwise interrupted. Free-
wheel settings are ignored when SYNC I/O is in 
Internal/Generate mode.

Example of Time Code Freewheel

In a 30 fps Pro Tools session, if Freewheel Dura-
tion/Time Code Freewheel is 28 frames, 
SYNC I/O will continue to generate until either 
the incoming time code signal is restored, or un-
til 28 frames elapse, whichever occurs first. 

To set freewheel duration from Pro Tools:

1  Choose Display > Session Setup. 

2  In the Time Code Freewheel section, enter a 
number of frames for time code freewheel. 

To set freewheel duration from the front panel:

1  Press Set, then use the Up or Down switches to 
show Freewheel Length (FrEE LEn) in the LED 
display.

2  Press Set again to access freewheel duration 
choices. 

3  Use the Up and Down switches to scroll 
through available choices (lowest is “4 F4” or 
four frames, highest is “40 Fr” or 40 frames). 
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4  When the desired freewheel duration is dis-
played, press Set. 

To set freewheel duration using SYNC I/O Setup:

■ Choose the desired amount from the Free-
wheel Duration menu. 

VITC and Positional Reference

VITC is a commonly used positional reference 
in professional audio post-production. Since 
VITC is time code information that is embedded 
as part of the video signal, VITC can be read 
when the VTR is paused or crawling slowly. 
When working with Pro Tools, this means that 
VITC can be used for Auto-Spotting regions to 
particular video frames. 

VITC is less prone to tape drop outs, and in this 
sense, is inherently more reliable than LTC. 
VITC can be embedded into any video signal, 
including digital video signals (tape or nonlin-
ear), without requiring an extra audio track to 
carry time code. 

Tape Protection Mode and VITC

In order for VITC to be read when a videotape is 
paused, the picture must remain visible. How-
ever, to save wear-and-tear on video heads, after 
a few minutes of still/pause mode, many VTRs 
will automatically drop into stop mode—which 
means the tape will be disengaged from the 
video heads, and VITC can no longer be read off 
the tape. To continue reading VITC, you may 
need to reengage still/pause, or press play and 
re-shuttle the tape to the desired frame. 
SYNC I/O Guide
Clock Considerations for VITC

To avoid tape protection mode problems and 
ensure constant clock referencing, use the Video 
Ref In as your clock reference instead of Video 
In, whenever possible. When using Video Ref In 
(and house sync), if the video picture disappears 
SYNC I/O will remain resolved to the black burst 
signal at the Video Ref In connector. 

To use VITC as SYNC I/O positional reference 
using Pro Tools:

1  Open the Session Setup window. 

2  Use the Positional Reference pop-up menu to 
select VITC.

To use VITC as SYNC I/O positional reference 
using the front panel:

■ Use the front panel Positional Reference 
switch to select VITC.

To use VITC as SYNC I/O positional reference 
using SYNC I/O Setup:

■ Choose Vertical Interval Time Code (VITC) 
from the Positional Ref pop-up menu. 

Additional VITC-Related Settings

SYNC I/O Settings Make sure to set the appro-
priate clock reference, sample rate, frame rate, 
and freewheel duration. 

Connections and Sources Make sure that your 
VITC-striped video signal, if any, is routed to 
SYNC I/O Video In connector (not the Video Ref 
In connector). If you use a black burst signal as 
clock reference connect it to the Video Ref In 
connector.



You should consider using Video Ref as your 
Clock Reference (rather than Video In) when 
working with VITC because a black-burst signal 
at the Video Ref input will always be there, un-
like the video signal at Video In, which may dis-
appear if the videotape disengages.

Auto Switch LTC/VITC Positional 
Reference

In Auto Switch mode, SYNC I/O switches auto-
matically between LTC and VITC depending 
upon which is delivering the best time code sig-
nal. This is indicated on the front panel by the 
LTC and VITC positional reference LEDs (both 
will be lit), and by a decimal point between the 
minutes and seconds. on the front panel time 
code display. 

VITC cannot be read at high speeds (shuttle 
speeds, for example) while LTC can, and LTC 
cannot be read at slow speeds (while VITC can 
be read at slow speeds, and when parked). Auto 
Switch LTC/VITC provides the best of both LTC 
and VITC reading without having to manually 
switch settings. 

To select Auto Switch LTC/VITC using Pro Tools:

1  Open the Session Setup window. 

2  Choose Auto Switch (LTC/VITC) from the Po-
sitional Reference pop-up menu.

To select Auto Switch LTC/VITC using the front 
panel:

■ Press the Positional Reference switch to select 
Auto Switch LTC/VITC (indicated when both 
the LTC and VITC LEDs are simultaneously lit).

To select Auto Switch LTC/VITC using SYNC I/O 
Setup:

■ Choose Auto Switch LTC/VITC from the Posi-
tional Ref pop-up menu.
Make sure to select the appropriate clock refer-
ence, sample rate, frame rate, and freewheel du-
ration options. 

Auto Switch LTC/VITC Requirements

• Make sure the LTC signal is routed properly to 
the SYNC I/O LTC In connector;

• Make sure the VITC-striped video signal is 
routed properly to the SYNC I/O Video In 
connector (not the Video Ref In connector);

• Make sure to have or stripe matching code on 
both your LTC and VITC tracks (and your on-
screen video window burn, if any).

• Make sure to select Auto or the correct line 
pair for VITC Read. 

Serial Time Code

SYNC I/O provides two 9-pin ports, to be used 
with MachineControl-enabled systems to re-
motely control, or follow, external 9-pin trans-
ports through the use of serial time code. 

For MachineControl-equipped Pro Tools sys-
tems, serial time code from either 9-pin port can 
be used for positional reference. This option is 
configured from the Pro Tools 
Peripherals > Machine Control window. For de-
tails on using serial time code with SYNC I/O, 
see the MachineControl Guide. 

Bi-Phase/Tach Positional Reference

Strictly speaking, Bi-Phase/Tach signals are 
clock reference signals, and do not contain posi-
tional information of their own. However, they 
do contain enough information for SYNC I/O to 
calculate positional information.

For additional information and examples of 
Auto Switch LTC/VITC, see “Auto-Switch 
LTC/VITC” on page 66 in Appendix A. 
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To calculate positional reference from Bi-
Phase/Tach requires that SYNC I/O be given a 
starting frame address, and a specific pulses-per-
frame value. Each of these related settings are 
explained in the following sections. 

To use Bi-Phase/Tach for positional reference:

Using Pro Tools:

■ Select Bi-Phase from the Positional Reference 
menu, located in the Session Setup window. 

Using the front panel controls:

■ Using the front panel Positional Reference 
switch, select Bi-Phase/Tach. 

Using SYNC I/O Setup:

1  Select Bi-Phase/Tach under SYNC I/O Setup’s 
Positional Ref pop-up menu. 

2  Set the starting frame as described in “Bi-
Phase/Tach Starting Frame” on page 44.

3  Set other Input Signals options, as appropri-
ate.

Bi-Phase/Tach Starting Frame

In order to use the Bi-Phase/Tach signal as a po-
sitional reference, SYNC I/O also needs to know 
the time code address for a particular frame of 
film. This positional relationship is established 
by parking the film device at a particular frame 
and setting SYNC I/O to the equivalent time 
code value using the Bi-Phase/Tach Starting 
Frame parameter. 

To set the starting frame for Bi-Phase/Tach from 
the front panel:

1  Select Set Gen (SE7 6En), using the Set, Down, 
and Up switches.

Bi-Phase start frame cannot be set from 
within Pro Tools. Use Sync Setup or the 
front panel. 
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2  Press the Set switch again to display time code 
numbers; one of the time code fields 
(hours:minutes:seconds:frames) will be flashing. 

3  Press the Down or Up switch to scroll through 
the current parameter.

4  To set a time code setting and advance to the 
next field, press and release the Down and Up 
switches simultaneously. 

5  Repeat until you have finished setting 
SYNC I/O to the desired generator start time. 

6  When you are done, press the Set switch 
again. The LED Time Code Display will stop 
flashing, and will show the start time you have 
just set. 

To set Bi-Phase/Tach start frame using SYNC I/O 
Setup:

1  In the Generator/Bi-Phase Preset section, type 
in the time code value of the starting frame, in 
hours:minutes:seconds:frames. 

2  When you have entered the proper starting 
frame, click Set. 

Bi-Phase/Tach Signal

To define the direction for a Bi-Phase/Tach input 
signal using the front panel controls:

1  Using the Set, Down, and Up switches, select 
Bi-Phase/Tach Input Signal (bIPH 5I6).

2  Press the Set switch. The LED Time Code Dis-
play will switch to display one of the four pa-
rameter values: 

A LEAd b Bi-Phase: FWD = A leads B — Here, 
when the A square wave is ahead of the B square 
wave, the direction of the Bi-Phase signal is un-
derstood to be “Forward.” 



b LEAd A Bi-Phase: FWD = B leads A — Here, 
when the B square wave is ahead of the A square 
wave, the direction of the Bi-Phase signal is un-
derstood to be “Forward.” 

r–n–d LO Tach: FWD = B is Low. Here, when the 
B signal is in a “low” state, the rate and direction 
(“r–n–d”) of the Tach signal is understood to be 
“Forward.”

r–n–d HI Tach: FWD = B is High. Here, when the 
B signal is in a “high” state, the rate and direc-
tion (“r–n–d”) of the Tach signal is understood 
to be “Forward.”

3  Use the Down and Up switches to switch be-
tween the parameter values. 

4  When you have chosen your desired option, 
press Set. 

Bi-Phase/Tach Pulses-per-frame (PPF)

There are several different standards for the 
number of pulses-per-frame output by Bi-Phase 
or Tach devices. Using SYNC I/O Setup’s Pulse 
Per Frame setting, you can set SYNC I/O to oper-
ate from 2 to 254 pulses per frame. The setting 
should match the PPF rate of the external de-
vice’s Bi-Phase/Tach encoder.

To set the pulses per frame value for a Bi-
Phase/Tach signal using the front panel:

1  Using the Set, Down, and Up switches, select 
Bi-Phase/Tach Pulses Per Frame (bIPH PPF):

2  Press the Set switch again. The LED Time Code 
Display will switch to display the current PPF 
value. 

3  Use the Down and Up switches to scroll 
through the parameter values (range is from 2 to 
255 pulses per frame). Holding either switch will 
scroll at a faster speed. 

4  When you have chosen your desired option, 
press Set.
Bi-Phase Position Trimming

While using bi-phase as your positional refer-
ence, you can trim the Bi-Phase-to-time code 
translation at any time. Each press of the Up 
switch will advance the time address one frame. 
Each press of the Down switch will retard the 
time address by one frame. Remember how 
many presses you've accumulated so that you 
can go back and trim the starting address you 
previously programmed in. 

Generating & Regenerating 
Time Code 
SYNC I/O generates LTC, VITC, and MTC simul-
taneously, obtaining time addresses from a vari-
ety of sources:

• When the Positional Reference is set to Gen-
erate, SYNC I/O generates LTC, VITC, and 
MTC from an internal time address clock. This 
is referred to as Generator Preset mode.

• When the Positional Reference is LTC, VITC, 
or Bi-Phase, SYNC I/O generates LTC, VITC, 
and MTC based on the time address of one of 
those sources. This is sometimes called re-gen-
eration” or “translation”. For SYNC I/O, this 
is referred to as Read/Regeneration mode. 

Read/Regeneration Mode

In this mode, SYNC I/O regenerates time code 
based upon external positional reference infor-
mation (LTC or VITC time code, or a Bi-
Phase/Tach signal). Subject to certain condi-
tions, three types of time code (LTC, VITC, and 
MTC) are simultaneously regenerated from the 
selected positional reference. 

Time code generated by the SYNC I/O does 
not follow session Pull Up and Pull Down 
settings.
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Requirements for Read/Regeneration of LTC, 
VITC and MTC

LTC The external positional reference must be 
moving at normal, 1x forward speed (±8%). 

VITC The positional reference must be LTC or Bi-
Phase/Tach, at any readable speed, forward or 
reverse, or when the positional reference is set to 
Generate. SYNC I/O will not regenerate VITC if 
the positional reference is VITC. 

MTC In order for SYNC I/O to regenerate contin-
uous MTC, the external positional reference 
must be moving at normal, 1x forward speed 
(±8%). Outside of this speed range and direc-
tion, MTC is generated in bursts every 200 mil-
liseconds. This allows MTC-slaved devices to 
read VITC or Bi-Phase properly in either direc-
tion, and at speeds down to zero. SYNC I/O be-
gins regenerating MTC as soon as it again de-
tects a valid positional reference signal. 

If the positional reference is LTC or VITC, 
SYNC I/O will regenerate time code addresses 
that match the incoming time code addresses. If 
the positional reference is a Bi-Phase/Tach sig-
nal, SYNC I/O will generate time code addresses 
starting at the Bi-Phase preset start time. (See 
“Bi-Phase/Tach Starting Frame” on page 44 for 
more information.)

Generator Preset Mode 

In this mode, SYNC I/O generates time code in-
ternally from a start time based upon the Gener-
ator Preset Time. Using either SYNC I/O Setup 
or the front panel controls, you can start, stop, 
resume, and reset time code generation. 

To optionally mute idle time MTC output, 
see “MTC Output and Idle Muting” on 
page 51.
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When generating time code in Generator Preset 
Mode, the SYNC I/O time code generator is re-
solved (locked) to one of three possible sources, 
based upon the following Generator Reference 
rule.

Generator Reference Rule

◆ If the Clock Reference is set to Internal, LTC, 
Pilot Tone, Bi-Phase/Tach, Digital (AES/EBU), or 
Digital (Word Clock), then the time code gener-
ator will lock to the selected clock reference.

– or –

◆ If the Clock Reference is set to one of the two 
video inputs (Video Ref In or Video In), then the 
time code generator will reference the Video Ref 
In connector.

24 fps and Frame Rate Restrictions

24 FPS cannot be used as the SYNC I/O time 
code format when the Positional Reference is set 
to Generate and the Clock Reference is either 
one of the two video inputs.

Furthermore, under these same conditions, if 
the video format is set to NTSC, only 29.97 FPS 
and 29.97 DF FPS may be chosen as the time 
code format, and, if the video format is set to 
PAL, only 25 FPS may be chosen as the time 
code format.

These restrictions are removed when not in 
Generate mode.

Generator Start Time

To set the generator start frame from Pro Tools:

■ Configure the Session Setup window as appro-
priate for your system and the current project. 
Refer to the Pro Tools Reference Guide for specific 
instructions. 



To set the generator start frame from the front 
panel:

1  Select Set Gen (SE7 6En), using the Set, Down, 
and Up switches.

2  Press Set again. One of the time code fields dis-
played will be flashing. 

3  To lower or raise the currently flashing param-
eter press Down or Up. Hold down either switch 
to scroll down/up.

4  To set a time code setting and advance to the 
next field, press and release Down and Up si-
multaneously. 

5  Repeat until you have finished setting 
SYNC I/O to the desired generator start time. 

When you are done, press Set again. SYNC I/O 
will retain the setting, even when the unit is 
powered off and on again, until it is changed.

LTC Generation/Regeneration

Regenerating LTC

SYNC I/O will regenerate LTC whenever the ex-
ternal positional reference is moving at normal, 
1x forward speed (±10%).

Make sure LTC is correctly routed as explained 
in Chapter 2, “Installation and Getting Started”. 
If you need to adjust the level of the SYNC I/O 
LTC output signal, see “Example: Using Set, 
Down and Up to adjust LTC Gain” on page 34 
for instructions. You can also adjust the 
SYNC I/O LTC servo gain, as described in “Servo 
Gain” on page 58. 

To regenerate LTC using Pro Tools:

■ In the Session Setup window, select any exter-
nal positional reference (except Generate). 
To regenerate LTC using the front panel:

■ Using the SYNC I/O Positional Reference 
switch, select the desired external positional ref-
erence (do not select Generate). 

To regenerate LTC using SYNC I/O Setup:

■ Select the desired external positional refer-
ence from the Positional Reference pop-up (any 
choice except Generate). 

SYNC I/O regenerates LTC as soon as it receives 
a valid positional reference signal. 

Generating LTC

In Generator Preset mode, SYNC I/O can gener-
ate LTC using either an external or internal 
clock reference. Make sure LTC is correctly 
routed and that all your other gear is properly 
configured before you begin. See “Example: Us-
ing Set, Down and Up to adjust LTC Gain” on 
page 34 for SYNC I/O LTC instructions. If neces-
sary, adjust the input level for the destination 
device. 

To generate LTC using Pro Tools:

1  In the Session Setup window, choose Generate 
from the Positional Reference pop-up menu. 

2  Put Pro Tools online. 

3  Start Pro Tools recording or playback. 
Pro Tools commands SYNC I/O to begin gener-
ating LTC with time addresses synchronized to 
the session time line.

To generate LTC using the front panel controls:

1  Using the SYNC I/O Positional Reference 
switch, select Generate. 

2  Configure the desired time code start in 
hours:minutes:seconds:frames using the Set, Up 
and Down switches. See “Generator Start Time” 
on page 46 for instructions.
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3  To begin generating, press and release the 
Run/StopClear switch. 

To generate LTC using SYNC I/O Setup: 

1  Select Generate in the Positional Ref pop-up 
menu. 

2  In the Generator/Bi-Phase Preset window 
(time fields), type in the desired time code start 
time, in Hrs:Min:Sec:Frm. To reset, click Zero. 

3  To begin generating, click Run. 

4  When you have finished generating the de-
sired length of LTC, click Stop. 

VITC Generation/Regeneration

When you use SYNC I/O to regenerate or gener-
ate VITC, you’ll be inserting VITC into an exist-
ing video signal. The input is derived according 
to the following rule. 

VITC Video Source Rule

Since SYNC I/O has two video inputs (“Video 
In” and “Video Ref In”), the following rule de-
scribes which of these two signals VITC is ap-
plied to.

◆ If the Positional Reference is set to Generate 
and the Clock Reference is set to either of the 
two video inputs, then VITC will be applied to 
the video signal at the Video Ref In connector 
and fed to the Video Out connector.

◆ Under all other combinations of Positional 
Reference and Clock Reference, VITC will be ap-
plied to the video signal at the Video In connec-
tor and fed to the Video Out connector. 

In addition, SYNC I/O will not insert new VITC 
while reading VITC from an external source. 
This is a safety feature to prevent the loss of ex-
isting VITC in the video stream. Thus, VITC is 
never inserted when the Positional Reference is 
set to VITC or Auto Switch LTC/VITC.
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Example Video Input Configuration

One common situation is transferring video 
from a source VTR (or a nonlinear video editing 
system) to a destination VTR (or a nonlinear 
video editing system). The video source signal is 
connected to one of SYNC I/O’s video input 
connectors according to the VITC Video Source 
rule.

The SYNC I/O Video Out signal is connected to 
the destination device. SYNC I/O is then able to 
stripe the second VTR’s videotape with VITC. 
(At the same time, you might also want to insert 
a window burn, as described in “Window Burn 
Display Options” on page 53.) 

To prevent destruction of the original VITC 
code, SYNC I/O will not re-apply (regenerate) 
VITC onto the same video stream from which it 
is reading VITC. 

LTC If you want to use LTC as a positional 
source, do not select Auto Switch LTC/VITC.

External  In order for SYNC I/O to regenerate 
VITC based on an external positional reference, 
you’ll need to select both a clock reference and a 
positional reference. 

To regenerate VITC based on an external 
positional reference from the front panel:

1  Connect the video source to the SYNC I/O 
Video Ref connector and loop to the SYNC I/O 
Video Input connector.

2  Select VITC Insertion (VI7C In5), using the 
Set, Down, and Up switches. 

3  Press the Set switch again. The LED Time Code 
Display displays one of the two parameter val-
ues (On or OFF).

Unlike LTC, SYNC I/O can regenerate 
VITC with both forward and reverse time 
code addresses.



4  Use the Down and Up switches to switch be-
tween the parameter values. 

5  Press Set to select VITC Insertion.

6  Make sure you have selected the appropriate 
format (NTSC or PAL, depending on your 
project). For instructions, see “Video For-
mat/System” on page 59. 

7  Use Set, Up and Down to access the VITC Gen-
erate Lines (6En LInE) parameter. Press the Set 
switch again. The default line pair is14/16, 
which is also the SMPTE-recommended setting.

8  Use the Down and Up switches to scroll 
through the parameter values and select a new 
VITC line pair, if necessary. When you have cho-
sen your desired line pair, press Set. The LED 
Time Code Display will return to showing time 
code numbers. 

9  Select valid clock and positional references. 

SYNC I/O will now regenerate VITC and insert it 
onto the video signal (as soon as it receives a 
valid positional reference signal). 

To regenerate VITC based on an external 
positional reference using SYNC I/O Setup:

1  Ensure that SYNC I/O is connected in-line 
with a video source and video destination.

2  Ensure that VITC Insertion Enabled is checked 
in the SYNC I/O Setup window and that you 
have selected the appropriate format (NTSC or 
PAL). 

3  Use the VITC Generate Lines menu to config-
ure the line pair, if necessary. 

4  Select the appropriate clock reference. 

5  Select either LTC or Bi-Phase/Tach from the 
SYNC I/O Setup Positional Reference pop-up 
window:
SYNC I/O will now regenerate VITC and insert it 
onto the video signal (as soon as it receives a 
valid clock reference signal and positional refer-
ence signal). 

Internal VITC Generation

SYNC I/O can also generate VITC internally, us-
ing its integral time code generating feature. In 
this mode (Positional Reference switch = Gener-
ate) you can use either an external clock refer-
ence, or the SYNC I/O internal crystal as a clock 
reference with a variable start time.

When generating VITC internally, if the inser-
tion is not timed based upon an upstream video 
reference you may encounter repeated or 
skipped VITC frames. Be sure to check “VITC 
Timing Rule” on page 65 and “VITC Video 
Source Rule” on page 48.

To generate VITC internally using the front panel 
controls:

1  Ensure that SYNC I/O is connected in-line 
with a video source and video destination.

2  Select VITC Insertion (VI7C In5), using the 
Set, Down, and Up switches. For detailed in-
structions, see “VITC Insertion” on page 56. 

3  Use the Down and Up switches to display 
VITC Insertion on/off. 

4  When on is selected, press Set. 

5  Select VITC Generate Lines (6En LInE), using 
the Set, Down, and Up switches. 

6  Press the Set switch again. The default line 
pair is 14/16, which is also the SMPTE-recom-
mended setting.

7  Use the Down and Up switches to scroll 
through the parameter values. When the desired 
line pair value is displayed, press Set.
Chapter 4: Using Sync I/O 49



50
8  Using the Positional Reference switch, select 
Generate. 

9  Set the time code start time. See “Generator 
Start Time” on page 46 for instructions.

10  Arm the destination VTR to record video, so 
that VITC can be inserted into the video signal, 
and be recorded on the destination videotape. 

11  Make sure that your chosen clock reference is 
actually present and running, then press the 
SYNC I/O Run switch. 

The time code addresses will begin to incre-
ment. 

To pause or stop VITC from the front panel:

■ Press and release the Run/Stop/Clear switch 
when you want to pause or stop the generating 
process.

To generate VITC Internally using SYNC I/O 
Setup: 

1  Ensure that SYNC I/O is connected in-line 
with a video source and video destination.

2  Ensure that VITC Insertion Enabled is selected 
in the SYNC I/O Setup window, and that you 
have selected the appropriate format (NTSC or 
PAL). 

3  If necessary, select onto which line pair you’ll 
be generating VITC using the VITC Generate 
Lines pop-up menu. 

4  Select the appropriate clock reference, using 
SYNC I/O Setup’s Clock Ref selector. 

5  From the Positional Ref selector, select Gener-
ate. 

6  In the Generator/Bi-Phase Preset window, 
type in the desired time code start time, in 
Hrs:Min:Sec:Frm. To reset to 00:00:00:00, click 
Zero. 
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7  Click Set. Typically, at this point you would 
arm the destination VTR to record video, so that 
VITC can be inserted into the video signal, and 
be recorded on the destination videotape. Make 
sure that your chosen clock reference is actually 
present and running, and that it is synchronized 
with the incoming video signal

8  Click Run to start. The time code addresses 
will begin to increment. 

9  Click Stop when you want to pause or stop the 
generating process. 

MTC Generation/Regeneration

MTC (MIDI Time Code) is a serial digital signal. 
In many ways, you can think of it as an inaudi-
ble type of LTC, that can be used by various 
MIDI devices. 

MTC is available from the SYNC I/O MTC Out 
connector, which is a standard DIN-style 5-pin 
female MIDI connector.

To use MTC, you’ll need to connect MTC Out to 
a MIDI In connector of a device that can recog-
nize and use MTC. Typically, this would be a 
console, sequencer, synthesizer or sampler key-
board, a drum machine or other device. 

Regardless of whether you are generating or 
regenerating, an active video signal will 
need to be present at one of the SYNC I/O 
video inputs. If in doubt, always check if the 
machine is paused, stopped or unlaced. 



MTC Output and Idle Muting

MTC is normally output whenever LTC is out-
put. Whenever LTC output stops, SYNC I/O will 
continue to output MTC in bursts of one frame 
every 200 milliseconds. This allows any con-
nected MIDI-reading device to be continuously 
updated as to the position of VITC or Bi-Phase 
(either of which might be operating at slow or 
still speeds). Thus, you can still use a connected 
MIDI device for Auto-Spotting from VITC or Bi-
Phase. 

Optionally, this constant output can be set to 
mute when time code (LTC) is idle. 

To mute idle-time MTC output from the front panel:

1  Use the front panel Set, Up and Down 
switches to display Idle MTC (IdLE 7C).

2  Press Set to display the current state (On or 
Off).

3  Press Up or Down to toggle Idle MTC to the 
Off setting.

4  Press Set again to exit and return SYNC I/O to 
its previous state.

To mute idle-time MTC output using 
SYNC I/O Setup:

1  Launch SYNC I/O Setup. 

2  Deselect the Idle MTC Enabled option. 
Generating a Window Burn
SYNC I/O offers time code character generation 
(also known as window burn or dubbing). This 
superimposes onto a video signal a small area 
called a window dub (or window burn, or time 
code window) that displays time code in 
hours:minutes:seconds:frames. 

A window dub can be very helpful for anyone 
involved in audio-for-picture, since it gives you 
an instant, visual cue as to where you are in 
time. 

When working with Pro Tools, for instance, you 
can use a window dub to help locate a particular 
video frame that has been cued by the director 
for a particular sound effect. Or, if you’re using 
Pro Tools and you want to spot a region to the 
same video frame at which you’ve paused your 
videotape, you can enter the time code reading 
you see in the window dub into the Auto Spot 
dialog. (This is especially useful if your only 
time code reference from the tape is LTC, as 
Auto-Spot requires VITC.)

SYNC I/O's character generator obtains its time 
code address from the chosen Positional Refer-
ence.

Video image with window burn
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Window Dub Requirements

Existing Video Signal  SYNC I/O can only burn a 
window dub onto an existing video signal. This 
means that at least one video “source” signal 
(from a VTR, nonlinear editing system, or other 
video device) must be present at one of the 
SYNC I/O video input connectors (Video In or 
Video Ref In). When generating a window dub, 
the VITC Timing Rule applies (see “VITC Timing 
Rule” on page 65. 

SYNC I/O Output The signal from the SYNC I/O 
Video Out connector must be routed to a video 
“destination” (such as another VTR or nonlinear 
editing system). 

To burn a window dub onto a video signal from Pro 
Tools:

1  Choose Setups > Peripherals and display the 
Synchronization page. 

2  Assuming SYNC I/O is enabled already, the 
Window Dub controls should be available. 

3  Click Enable Dub Window. 

4  Configure any of the following Window burn 
appearance settings: Size, Vertical Position, Hor-
izontal Position, and Color. 

Configuring SYNC I/O Window Dub from Pro Tools. 
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Size  Sets the relative size of the window dub. 
The choices are Small or Large. The default set-
ting is Large.

Vertical Position  Sets the vertical position of the 
window dub, relative to the bottom of the video 
picture. The choices range from 10% From Bot-
tom to 50% From Bottom, in 10% increments. 
The default setting is 20% From Bottom.

Horizontal Position  Sets the window dub’s rela-
tive horizontal position within the video pic-
ture. The choices include Extreme Left, Left, 
Center, Right and Extreme Right. The default 
setting is Center.

Color  Sets the color of the time code numbers in 
the window dub, and the color of the window 
dub’s background. The choices include White 
on Black Bkgnd; Black on White Bkgnd; White 
on Video Bkgnd; or Black on Video Bkgnd. 
(Video Bkgnd means that the window dub’s 
background is transparent, so that the time code 
numbers are displayed directly on top of the 
video signal, without a contrasting background 
box.) The default setting is White on Black 
Bkgnd.

5  After configuring the dub window settings, 
click OK to close the Peripherals window. 

“10% from Bottom” vertical position is out-
side the standard “safe title” area, which 
means it may not be visible on some video 
monitors.

The “Extreme” horizontal positions are out-
side the standard “safe title” area, which 
means they may not be visible on some 
video monitors.



To enable window dub using the front panel 
controls:

1  Using the Set, Down, and Up switches, select 
Burn Enabled (burn EnA).

2  Press the Set switch again. The LED Time Code 
Display will switch to display the current On or 
Off setting for Window Burn.

3  Use the Down and Up switches to switch be-
tween the parameter values. 

4  When you have chosen your desired option, 
press Set.

Based upon the selected positional reference, 
the time code character generator can now burn 
time code addresses onto any video signal that’s 
passing through SYNC I/O. 

Window Burn Display Options

If you need to change the appearance of the 
window dub—in terms of size, vertical position, 
horizontal position, and color—you’ll need to 
use Pro Tools or SYNC I/O Setup. These parame-
ters cannot be adjusted from the SYNC I/O front 
panel controls. 

To configure Window Dub using SYNC I/O Setup:

1  In the Dub Window section of SYNC I/O 
Setup, select Window Enabled. 

2  Specify the appearance of the window dub 
with the pop-up menus for Vertical Position, 
Horizontal Position, and Color. 

Default Window Burn settings are listed in 
“Restoring Factory Settings” on page 62. 
3  Ensure that all the proper video connections 
have been made, and that you’ve selected the 
correct positional reference.

After you have completed these steps, you’ll 
burn a window dub—with time code addresses 
based upon the selected positional reference—
onto any video signal that’s passing through 
SYNC I/O. 

To turn off window dubbing:

■ Deselect Window Enabled.
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chapter 5

Additional Operational Information
Front Panel 
Generator/Parameter 
Controls
This section details the parameters available 
from the multi-function SET, UP, DOWN and 
RUN/STOP, CLEAR switches. (Referred to as Set, 
Up, Down and Run). Detailed instructions for 
the multi-function Generator/Parameter 
switches can be found in the section “Using the 
Front Panel Generator/Parameter Switches” on 
page 33.

Parameters

SYNC I/O parameters are selected and edited us-
ing the four Generator/Parameter switches. 

To select SYNC I/O front panel parameters:

1  Press Set. 

2  Use the Up and Down switches to scroll 
through available parameters, described below. 

The 7-segment LEDs in the Generator/Parame-
ter Display abbreviate some parameter names 
using numerals to represent letters (such as “5” 
to represent “S” or “s”). The following table 
identifies each of these abbreviations. 
Front Panel Parameters

SYNC I/O LED display of abbreviated parameter names

LED Parameter

SE7 6En Set Generator Start Time

dI6 rEF Digital Reference 

SPL FrEC Sample Freq (Rate)

PuLL r7E 1 Pull Up/Down 0.1%

PuLL r7E4 Pull Up 4.167%, Down 4.0%

bASE CLOC External Clock Out

VI7C InS VITC Insertion

rdr LInE (VITC) Reader Line

6En LInE (VITC) Generate Line

burn EnA Window Burn On/Off

FrEE LEn Freewheel Duration

L7C 6AIn LTC Output gain

SErVo Gn LTC Servo gain

PICH HLd Pitch Hold On/Off

bIPH PPF Bi-Phase Pulse-per-frame

bIPH SI6 Bi-Phase Signal Configuration

VIdEO SY Video Format (NTSC/PAL)

IdLE 7C Idle MTC On/Off

USD CPA7 USD Compatibility On/Off
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Set Generator Start Time

Lets you set a start time for the SYNC I/O time 
code generator. 

See “Generator Start Time” on page 46.

Digital Clock Reference

SYNC I/O can use AES/EBU or Word Clock (1x) 
for digital clock reference. 

See “Digital Clock” on page 36.

Sample Rate

Selects the SYNC I/O sample rate. 

See “Sample Rate” on page 17.

Pull Rate

Two Pull Rate settings enable 0.1%, and 4%, Pull 
Up or Pull Down for the current sample rate. 

Pull Rate1 Lets you enable 0.1% pull up or 
down.

Pull Rate4 Lets you enable 4.167% pull up, or 
4.0% pull down, when available. 
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Base Clock

Configures the Word Clock Out port. Choices 
are Session (1x the base session sample rate), or 
256x (for Slave Clock devices).

VITC Insertion

When selected, VITC will be inserted onto the 
outgoing video signal—assuming that a video 
signal is present at one of the SYNC I/O video 
inputs, and that SYNC I/O is in a valid mode for 
inserting VITC. 

To configure SYNC I/O to insert VITC using the 
front panel:

1  Select VITC Insertion (VI7C InS) using the Set, 
Down, and Up switches. 

2  Press Set again. The Time Code Display shows 
On or Off. 

3  Use Down an Up to toggle the choices.

4  Press Set when the desired choice is shown.

The base sample rate is 44.1 kHz when ses-
sion sample rate is 44.1, 88.2, or 176.4 
kHz, or 48 kHz when session sample rate is 
48, 96, or 192 kHz. 



VITC Read Lines

This setting determines which line pair of in-
coming video is used for the VITC source. 
 

To choose the VITC read lines:

1  Select VITC Read Lines (rdr LInE), using the 
Set, Down, and Up switches. 

2  Press Set switch. The Time Code Display will 
shows one of the parameter values: 

• Auto (ALL-LInE)—where SYNC I/O will search 
all lines and select the first valid line pair au-
tomatically

• the currently selected read lines, if different. 

3  Use Down and Up to scroll parameters. 

4  Press Set when the desired read line is shown. 

VITC Generate Lines

This setting determines the line pair of the video 
signal at the Video Out connector onto which 
SYNC I/O inserts VITC. Normally, this should be 
left at the default setting of 14/16. 

To choose the VITC generate lines:

1  Select VITC Generate Lines (6En LInE), using 
the Set, Down, and Up switches.

2  Press Set again. The LED Time Code Display 
displays the current lines. 

3  Use Down and Up to scroll parameters. 

4  When you have chosen your desired option, 
press Set. SYNC I/O will retain the setting, even 
when the unit is powered off and on again, until 
it is changed.
Window Dub/Burn

By enabling this setting, you can superimpose a 
window dub onto an incoming video signal. 
 

The front panel lets you enable window dub but 
not adjust any window options. 

To enable or disable the SYNC I/O window dub 
from the front panel:

1  Select Burn Enabled (burn EnA), using the Set, 
Down, and Up switch. 

2  Press Set again. 

3  Use Down and Up to toggle between on/off. 

4  When you have chosen your desired option, 
press Set. SYNC I/O will retain the setting, even 
when the unit is powered off and on again, until 
it is changed. See “Generating a Window Burn” 
on page 51 for Pro Tools and SYNC I/O Setup 
window dub instructions. See “SYNC I/O De-
faults” on page 62 for default display settings. 

Freewheel Length/Duration

Freewheel Length sets the period of time for 
which SYNC I/O will continue to regenerate 
time code when incoming time code is inter-
rupted. 

See “Freewheel Duration” on page 41 for an ex-
planation of this feature. 

To set the freewheel duration:

1  Select Freewheel Length (FrEE LEn), using the 
Set, Down, and Up switches. 
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2  Press Set again. The LED Time Code Display 
displays the current setting, in frames. 

3  Use Down and Up to scroll parameters. 

4  Press Set when the desired value is shown.

LTC Output Level/Gain

Adjusts the audio level of the SYNC I/O LTC 
output, from –24 dBu to +9 dBu. 

See “Example: Using Set, Down and Up to adjust 
LTC Gain” on page 34 for step-by-step LTC gain 
instructions. 

To set the LTC output level:

1  Select LTC Gain (L7C 6AIn), using the Set, 
Down, and Up switches. 

2  Press the Set switch again. The LED Time Code 
Display shows the current setting, in dBu. 

3  Use the Down and Up switches to switch be-
tween the parameter values. 

4  When you have chosen your desired option, 
press Set. 

Servo Gain

This setting provides a user selectable LTC input 
gain offset. Selectable from the front panel only, 
this parameter can significantly lessen or re-
move jitter on word clock while resolving to 
LTC (though it can slightly increase lockup 
time). 
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To set the LTC servo gain:

1  Select Servo Gain (SErVo Gn) using the Set, 
Down, and Up switches. 

2  Press Set again. The LED Time Code Display 
shows the current setting (-001 is the default). 

3  Use the Down and Up switches to display an-
other parameter value. Servo gain provides four 
gain settings. 

4  When you have chosen the desired option, 
press Set. 

Pitch Memory/Hold

Pitch Memory is useful when resolving 
SYNC I/O to off-speed, free-running LTC. When 
Pitch Memory is enabled, SYNC I/O will remain 
at a pitch (sample rate) that corresponds to the 
last known clock reference speed. 
 

To enable or disable SYNC I/O pitch memory 
feature:

1  Select Pitch Hold (PICH HLd), using the Set, 
Down, and Up switches. 

2  Press Set again. The LED Time Code Display 
will display the current setting (on or off). 

3  Use Down and Up to scroll parameters. 

Turn off Pitch Memory if you want to digi-
tally transfer to another device and to en-
sure the receiving device gets the correct 
sample rate. Also, turn pitch memory off if 
you are doing an analog transfer to 
Pro Tools and want to ensure that the re-
cording is made at the exact sample rate set 
by the session set up window.



4  When you have chosen your desired option, 
press Set. SYNC I/O retains the setting, even 
when powered off, until it is changed.

Bi-Phase/Tach Pulses Per Frame

Bi-Phase/Tach involve several settings, includ-
ing pulse per frame. This sets the number of Bi-
Phase/Tach pulses per frame of time code. 

To set the pulses per frame value for a Bi-
Phase/Tach signal:

1  Select Bi-Phase/Tach Pulses Per Frame (bIPH 
PPF), using the Set, Down, and Up switches. 

2  Press Set again. The LED Time Code Display 
shows the current parameter values, in pulses 
per frame. The readout will look similar to this: 

0002

3  Use Down Up to scroll parameters. Pressing 
and releasing the switches will change the value 
by just one pulse per frame. Pressing and hold-
ing the switches scrolls at a faster speed. 

4  When you have chosen your desired option, 
press Set. SYNC I/O will retain the setting, even 
when the unit is powered off and on again, until 
it is changed.

Bi-Phase/Tach Input Signal

In addition to other Bi-Phase/Tach parameters, 
the Input Signal defines the direction of the Bi-
Phase/Tach signal.

For complete instructions, see “Bi-Phase/Tach 
Signal” on page 44.
Video Format/System

Selects the format (NTSC or PAL) for both the in-
coming and outgoing video signals.

NTSC  The standard for North and South Amer-
ica, Japan, and certain other parts of the world

PAL Used in most of Europe, Asia, and Africa. 
Users of SECAM video (for France, Russia, and 
other parts of the world) should select PAL. 

To select the desired video system:

1  Select Video System (VIdEo SY), using the Set, 
Down, and Up switches. 

2  Press Set again. The LED Time Code Display 
will show one of the following: 

• NTSC (n75C)

• PAL (PAL)

3  Use Down and Up to toggle parameters. 

4  When you have chosen your desired option, 
press Set. 

SYNC I/O will retain the setting, even when the 
unit is powered off and on again, until it is 
changed.

MTC Idle Mute

MTC is output constantly whenever SYNC I/O is 
generating time code. Optionally, this output 
can be muted when time code (LTC) is idle. 

Please be sure you have selected the correct 
format! SYNC I/O will not warn you if you 
have chosen the wrong one.
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To mute idle-time MTC output from the front panel:

1  Use the front panel Set, Up and Down 
switches to display Idle MTC (IdLE 7C).

2  Press Set to display the current state (On or 
Off).

3  Press Up or Down to turn Idle MTC off. 

4  Press Set again to exit and return SYNC I/O to 
its previous state.

For SYNC I/O Setup instructions for Idle MTC, 
see “MTC Output and Idle Muting” on page 51.

USD Compatibility Mode

This setting lets you turn USD emulation on and 
off, to support older Pro Tools systems and 
other audio systems. 

Using Fader Start
SYNC I/O provides six GPI outputs in total, two 
TTL-level and four relays. Together, this combi-
nation of outputs makes it possible for 
SYNC I/O to provide Fader Start capability. 

Fader Start allows faders in Pro Tools to trigger 
external devices to play and stop. 

To implement Fader Start, Pro Tools maps the 
first two visible auxiliary input channels in a 
session to GPI Relay outputs 0 and 1 (first being 
left-to-right in the Mix window, top-to-bottom 
in the Edit window).

Utilization of Fader Start has specific wir-
ing requirements. See “GPI Relay Wiring for 
Fader-Start” on page 88.
SYNC I/O Guide
Example Fader Start Application

In a typical scenario, the Fader Start feature con-
trols playback of a CD player. The CD player 
outputs are routed into a Pro Tools stereo Aux 
Input. As the Aux channel fader is moved above 
-120 dB, playback of the CD player is automati-
cally triggered. Likewise, as the fader is moved 
below -120 dB, playback is automatically 
stopped. 

To configure Pro Tools tracks for Fader Start Play 
and Stop:

1  Use the New Track dialog to create two new 
auxiliary input tracks. If you already have aux 
tracks, you will use the first and second (top-
most in the Edit window, left-most in the Mix 
window). 

2  When the first visible aux input in a Pro Tools 
session is above -120 dB, GPI Relay output 3 
(Fader Start #1) will be enabled; otherwise, it will 
be disabled.

Similarly, when the second visible aux input in 
a Pro Tools session is above -120 dB, GPI Relay 
output #4 (Fader Start #2) will be enabled; oth-
erwise, it will be disabled. 

If you rearrange channel strips in the Pro Tools 
Mix or Edit windows, the two GPI outputs will 
update dynamically to reflect the current state. 
The Fader Start channel must be in a Show Track 
state (not hidden). See “GPI Relay Wiring for 
Fader-Start” on page 88 for additional GPI infor-
mation. 

To rearrange tracks, drag the Track Name 
left or right in the Mix window, or up or 
down in the Edit window. See the Pro Tools 
Reference Guide for more information. 



Calibrating the SYNC I/O 
Oscillator
SYNC I/O provides a feature for calibrating the 
frequency of the on-board crystal oscillator. 
This allows SYNC I/O to be used as an extremely 
accurate frequency reference while in Inter-
nal/VSO mode.

With normal usage, SYNC I/O should never re-
quire recalibrating. Each unit is factory cali-
brated to within +/- 5 ppm (parts per million). 

You may want to recalibrate SYNC I/O in the 
following situations:

• If greater than 5 ppm accuracy is required

• If the unit needs to be matched to a unique 
(nonstandard) frequency

• To precisely compensate for component aging

– and –

• To restore the original factory setting 

Oscillator Resolution and Stability

SYNC I/O calibration units are in 1/64th of a 
sample period. What this means is that 
SYNC I/O can theoretically be calibrated to 
about 1/3 of a ppm. The unit will maintain cali-
bration across a wide range in temperature. 
Long-term drift should be less than 1 ppm per 
year due to aging of the crystal. To put this in 
perspective, most digital audio products are ac-
curate to within 20 to 50 ppm and drift with 
temperature. SYNC I/O’s accuracy is possible be-
cause it contains a low-jitter, high-stability tem-
perature controlled crystal oscillator.

Oscillator recalibration does not occur dur-
ing firmware updating or when resetting 
SYNC I/O to factory defaults (see “Restoring 
Factory Settings” on page 62). 
Warm Up SYNC I/O Before Recalibrating

Before you begin the calibration procedure, 
power on SYNC I/O and allow it to warm up for 
at least five minutes. The temperature of the 
room (or chassis) isn’t critical during the calibra-
tion procedure. However, if you need better 
than 3 ppm accuracy, it is recommended that 
you allow SYNC I/O to warm up for at least 30 
minutes and that the chassis be at normal oper-
ating temperature.

The original Oscillator Calibration value is 
printed on the factory sticker, on the SYNC I/O 
bottom panel. 

To restore the SYNC I/O oscillator calibration to 
its factory setting:

1  Press Set, then press Up until Video System 
(VIdEo SY) is displayed in the LED readout.

2  With the LED Time Code Display showing 
VIdEo SY, press and hold the Up switch. While 
you continue to hold that switch, press the 
Clock Reference switch momentarily, and then 
release both switches. The LED Time Code Dis-
play will read:

3  Press Set again. The LED Time Code Display 
shows the current parameter value, which 
shows a sample rate frequency deviation from 
–0999 to 0999. 

4  Take note of the Oscillator Calibration value 
printed on the factory sticker, on the SYNC I/O 
bottom panel. 

5  Use the Down and Up switches to scroll 
through the parameter values. 
Chapter 5: Additional Operational Information 61



62
6  When you reach a value that matches the 
sticker’s value, stop scrolling and press Set. The 
LED Time Code Display will return to showing 
time code numbers. Your SYNC I/O is now prop-
erly calibrated.

The next time you press Set, the LED Time Code 
Display will again show O5C CAL. If you then 
press the Down switch, you’ll disengage the Os-
cillator Calibration parameter name. To change 
the setting once again, you’ll need to repeat 
steps 1 through 6.

Restoring Factory Settings
SYNC I/O can be reset to its default factory set-
tings. 

To reset all parameters to default settings:

1  Switch off power to SYNC I/O and wait at least 
10 seconds. 

2  Hold down the Up and Down front panel 
switches and turn on power to SYNC I/O — do 
not release the Up and Down switches until the 
display reads FAC-CFG.

Resetting factory settings does not reset the 
SYNC I/O oscillator. See “Calibrating the 
SYNC I/O Oscillator” on page 61 for infor-
mation. 
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Factory Default Settings

The following table lists the default settings of 
each parameter. 

SYNC I/O Defaults
Parameter Name Default

Set Generator Start Time 00:00:00:00

Digital Reference AES-EBU

Sample Freq (Rate) 44.1 kHz

VITC Insertion On

Pull Rates Off

Base Clock Session (1x Word)

(VITC) Reader Line All 

(VITC) Generate Line 14 - 16

Window Burn On/Off On (Enabled)

Freewheel Duration 8 frames

LTC Output gain 3 dBu

Servo gain -001

Pitch Hold Off

Bi-Phase Pulse-per-frame 0100

Bi-Phase Signal A Lead B

Video System/Format NTSC

Idle MTC Enabled On

Window Burn options: Enabled

Size: Large

Vertical Position: 20% 
from Bottom

Horizontal Position: Center

Color: White on Black 
background

Variable Speed Offset 
(VSO) 

Off



Managing and Selecting Video 
Inputs
SYNC I/O has two independent video inputs, re-
ferred to as “Video In” and “Video Ref” on the 
SYNC I/O rear panel. These let you use one of 
the video inputs as a Clock Reference (the re-
solver sample clock master reference) and use 
the other input for working with VITC time 
code and the character generator (window dub).

Don't worry if you have just a single video 
source. SYNC I/O provides a very simple 
method for connecting your single video source 
to both of the video inputs. See “Using Video In-
puts with VITC and the Character Generator” 
on page 63. 

In a typical video setup, you will supply a refer-
ence video signal (black burst or color bars) to 
your VCR and to the SYNC I/O Video Ref input. 
You will then connect the VCR's video output to 
the SYNC I/O Video In port. Finally, the 
SYNC I/O Video Out will be fed to your picture 
monitor and/or another VCR.

Using Video Inputs with VITC and the Character 
Generator

Unlike selecting a video input to use for Clock 
Reference, input selection for VITC and charac-
ter generator functions follows a simple rule. 
This rule is explained in the following sections 
and in Figure 3 on page 64. 
Video Ref  If the Clock Reference is one of the 
two video inputs, and the Positional Reference is 
Generate, then VITC and character generator 
functions are applied to the video arriving at the 
Video Ref input connector. This helps you avoid 
re-patching video cables whenever you want to 
stripe a videotape with your reference black-
burst or color bars, along with internally gener-
ated time addresses for VITC (and/or LTC, 
and/or CG dub window). In Figure 3 on 
page 64, this scenario is identical to “Route A.” 

Video In For all other combinations of Clock 
Reference and Positional Reference, VITC and 
character generator functions are applied to the 
video signal arriving at the Video In connector. 
In this way, SYNC I/O can read VITC from your 
videotape, or add VITC with or without charac-
ter generation (window burn) while dubbing to 
a second VCR. In Figure 3 on page 64, this sce-
nario is identical to “Route B.” 

To understand why these rules exist, let’s exam-
ine how the circuitry works within SYNC I/O 
(see Figure 3):

The clock reference (labelled Sample Clock Re-
solver Circuit in Figure 3 on page 64) is select-
able at all times. You can decide which input 
signal to use to generate the digital clock signal. 

However, when the clock reference is set to 
Video, the positional (time code) reference cir-
cuitry (labelled Time Code and Window Dub 
Circuit in the illustration) is not switchable. 
This is because the positional (time code) refer-
ence circuitry is always used to derive time code, 
whether SYNC I/O is reading incoming time 
code or generating new time code. Even in Gen-
erate mode, SYNC I/O needs to use this circuitry 
to detect the frame edge of the video in order to 
generate time code.
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Figure 3.  Video Input Flow diagram, USD
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Super Clock Output
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         Circuit
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Bi-phase/Tach

Video routing is automatically switched within the
Universal Slave Driver, according to the Positional Reference 
and Clock Reference settings:

 • Route A — Positional Reference = Generate;
                     Clock Reference = Video Ref In or Video In

 • Route B — Any other combination of Positional Reference
                     and Clock Reference settings
SYNC I/O Guide



appendix a

Additional Synchronization Information
Video and VITC Signals

Black Burst and House Video Reference

A black burst signal is essentially a “position-
less” video signal. As with any “shared” video 
signal, you’ll want to ensure that your video 
feed comes from a properly buffered and distrib-
uted source, such as a video distribution ampli-
fier, or the house video reference/black burst 
output of another device in the chain. 

Resolving to video instead of house video 
reference (black burst)

There are several reasons why you would resolve 
SYNC I/O to a video signal rather than house 
sync. 

When House Video Reference is Unavailable Re-
solve to a video signal whenever you are syn-
chronizing Pro Tools (or other device) to video, 
and you either: 

• do not have a black burst generator

– or –

• your setup includes equipment that lacks 
house video reference /black burst input and 
synchronization capability (including con-
sumer grade VCR, or some entry-level PC-
based editing systems).
Simple Setups In a modest setting with one or 
two VTRs, Pro Tools and SYNC I/O, using the 
video signal as the clock reference is often satis-
factory. In these situations, proper sync can be 
achieved using the video signal as clock refer-
ence. 

Why VITC is Unavailable for Clock Reference

VITC itself does not provide clock information 
directly as part of its time code information, 
only positional information. However, since 
VITC is always embedded into a video signal, 
that video signal can be used as a clock reference 
by selecting Video Input as the clock reference 
(or Video Ref In if your facility has a house video 
reference).

VITC Timing Rule

The following rule is in effect whenever you are 
generating or regenerating VITC. 

◆ Inserted VITC should be monotonic, regard-
less of whether it is being regenerated or gener-
ated.

By monotonic, it is meant that the VITC should 
be smoothly ascending or descending, with no 
repeated or skipped frame addresses. In order to 
achieve monotonicity, the external positional 
reference (while regenerating) or the clock 
source (in Generator Preset Mode) must be syn-
chronous with the video signal onto which the 
VITC is being inserted. 
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Example of VITC Timing Rule

As an example, if you are using LTC as a posi-
tional reference from a 3/4-inch U-Matic VTR, 
then that VTR should be referenced to the same 
video signal that you are applying to SYNC I/O. 
As another example, in Generator Preset Mode 
(Positional Reference = Generate), a clock refer-
ence of Internal is not a good choice, simply be-
cause the SYNC I/O internal crystal runs asyn-
chronously with respect to the supplied video 
signal, and thus repeated or skipped frame ad-
dresses are sure to eventually occur.

LTC Signals
Because it’s an analog audio signal, LTC can 
sometimes be susceptible to either tape drop-
outs (tape shedding), or to level mismatches be-
tween the LTC source and the LTC input. The 
SYNC I/O freewheeling feature allows you to 
compensate for brief time code dropouts. How-
ever, if you have serious dropouts, you may not 
be able to sustain accurate synchronization. 

If you plan to use LTC as a clock reference 
(whether or not you are also using it as a posi-
tional reference), you will need to ensure that 
your LTC is recorded at as high a level as possi-
ble without distortion, and that there are no 
dropouts longer than 1/80th of a frame.

SYNC I/O reads LTC most reliably when fed 
with a LTC signal of at least -12 dBu (and prefer-
ably 0 dBu to +3 dBu.) 

LTC Servo Gain

You can adjust the servo gain of the SYNC I/O 
LTC input using the front panel controls. See 
“Servo Gain” on page 58 for more information.
SYNC I/O Guide
Working with Analog Machines

It is good practice on a 24-track analog tape ma-
chine to record time code on Track 24 at a refer-
ence level of -10 dBu (or lower), with Track 23 
left blank as a “guard” track. This practice avoids 
crosstalk “bleed” that can occur between the 
time code track and otherwise adjacent audio 
tracks. Time code (which is a mid-frequency al-
ternating pitch square wave) is very sensitive to 
crosstalk from adjacent tracks, and conversely 
you don’t want audible time code leaking onto 
your audio tracks. 

If your ATR is under the control of a synchro-
nizer, you must make sure that the synchronizer 
and SYNC I/O are both locked to the same refer-
ence source (such as, typically, from a video 
black burst generator.)

Auto-Switch LTC/VITC 
Auto-Switch LTC/VITC lets SYNC I/O automati-
cally select between these two (time code) 
sources. 

LTC and VITC both provide useful and unique 
capabilities. For instance, it is impossible to read 
LTC off a paused videotape. Consequently, us-
ing only LTC, there’s no way you can use Pro 
Tools to perform Auto-Spotting of regions when 
the tape is paused. However, VITC continues to 
be read as long as the picture remains visible, so 
it can be used as a positional reference when the 
VTR is paused. On the other hand, VITC cannot 
be read at fast winding speeds (except by broad-
cast-quality VTRs); LTC can be read at fast wind-
ing speeds, as long as its signal remains within 
the high-end frequency response of the ATR or 
VTR. 



Examples of Auto-Switch LTC/VITC

◆ SYNC I/O will switch to LTC for positional ref-
erence during hi-speed searching and cueing, 
for example, or whenever the tape speed is too 
high to read VITC.

◆ SYNC I/O will switch to VITC if LTC stops or 
is unavailable. This will include, for example, if 
a tape is paused or parked. 

◆ If both LTC and VITC are available, SYNC I/O 
chooses which one to use based on the speed of 
playback. The switch-over point is approxi-
mately 75% of full 1x playback speed. Above 
75% playback speed, LTC is favored; below 75% 
speed, VITC is favored.

If a dropout occurs, SYNC I/O waits until the 
freewheel duration has expired before attempt-
ing to switch over to the opposite source. If nei-
ther source is available, SYNC I/O will stop read-
ing time code.

Digital Clock Signal Types
A reference clock signal is part of any digital re-
cording system. It is required because whenever 
digital audio information is mixed together or 
passed between devices, the playback samples 
must be aligned with the recording samples. In 
some cases (such as with AES/EBU or S/PDIF dig-
ital interfaces), the clock signal is embedded in 
the data stream itself. In other cases, such as 
SDIF, the clock signal is carried as an entirely 
separate signal from the digital audio sample 
data.

SYNC I/O is able to resolve to AES/EBU and 
Word Clock. 
AES/EBU

Some professional digital audio products use 
AES/EBU “null clock” (which is an AES/EBU data 
stream that contains only clock information 
only and no audio information) as a system 
clock reference source. These systems rely upon 
a single AES/EBU master clock source that is dis-
tributed throughout a digital audio facility, in 
much the same way that house sync is distrib-
uted throughout a video facility. If you are con-
necting SYNC I/O to such a system, you will 
want to use the SYNC I/O AES/EBU input as the 
clock reference connection, so that all system 
components are referenced to the same time 
base. (Note that AES/EBU does not support 
176.4 kHz and 192 kHz sample rates.) 

In some cases (such as using SYNC I/O as a 
stand-alone clock resolver or time code genera-
tor without a digital audio workstation), you 
may wish to use an audio DAT machine (or 
other similar device) as a source of AES/EBU null 
clock, and resolve your system to this reference 
source. In this case, the audio sample data in the 
AES/EBU data stream is stripped off, and only 
the clock information is used. 

Word Clock

Many professional digital audio products—in-
cluding open-reel multitrack tape recorders, dig-
ital mixing consoles, and the Tascam DA-88 
modular digital multitrack—have Word Clock 
(1x sample rate) connectors. 

Word Clock allows the DA-88 (and other Word 
Clock-compatible devices) to send or receive ex-
ternal clock information which controls the 
sample rate, which in turn (where applicable) 
controls the play and record speed.
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Using just Word Clock, it is possible to create a 
“chain” of digital devices in your studio by pick-
ing one source as the Word Clock master, and 
configuring other sources as Word Clock slaves.

Bi-Phase/Tach
Bi-Phase and Tach are used with mag ma-
chine,16-, 35- and 70mm projectors, flatbed ed-
iting systems and other types of motor-driven 
film equipment. Bi-Phase (sometimes called 
Quadrature Sync) and Tach information are 
similar, though they do differ. 

Bi-Phase  A Bi-Phase signal consists of two 
square waves, which are generated directly by a 
device’s transport mechanism, and which are 
90° out-of-phase with one another. As a Bi-
Phase-generating device plays it outputs a 
steady stream of square waves that SYNC I/O 
can use as its clock reference, at nearly any speed 
including still/paused. 

SYNC I/O uses the phase relationship between 
the two square waves to determine the device’s 
direction (forward or reverse). However, this is 
relevant only when SYNC I/O is using the Bi-
Phase signal as a positional reference.

Tach A Tach signal is a variation of Bi-Phase. 
With Tach’s two signals, one is used only as the 
direction indicator, while the other is used as 
the velocity, or rate, indicator.SYNC I/O uses 
this rate signal when resolving to Tach as a clock 
reference. 

There are several different standards for the 
number of pulses-per-frame for Bi-Phase or Tach 
devices. Using SYNC I/O Setup’s Pulse Per Frame 
setting, you can set SYNC I/O to match the PPF 
rate of the external device’s Bi-Phase/Tach en-
coder.
SYNC I/O Guide
Strictly speaking, Bi-Phase/Tach signals are clock 
reference signals, and do not contain positional 
information of their own. However, they do 
contain enough information for SYNC I/O to 
calculate positional information. 

Bi-Phase/Tach signals use two square waves to 
generate pulses that can function as a clock ref-
erence. The two square waves are 90° out-of-
phase, in a pattern that resembles this:

With a Bi-Phase signal, SYNC I/O can deduce 
the direction (forward or reverse) of the signal 
based upon which wave is read “high” relative 
to the other. For instance, with some film equip-
ment, when the device is running forward, it 
will generate a Bi-Phase signal where the “A” 
wave leads the “B” wave—that is, where the A 
wave peaks before the B wave peaks. When the 
device is in reverse, the B wave will lead the A 
wave. 

However, some film equipment works in the op-
posite manner, which is why the SYNC I/O In-
put Signals option lets you make the appropriate 
selection (Fwd = A leads B, or Fwd = B leads A). 

Calculating the direction of a Tach signal is 
slightly different. As you may recall, Tach also 
uses two signals. The “A” signal is a square wave 
that provides clock information; the “B” signal 
is in a steady state (high or low) that indicates 
the direction. Unfortunately, not all Tach-gen-
erating equipment uses the B signal in the same 
way. Fortunately, the SYNC I/O Input Signals 
options allows you to choose the appropriate 
method (Tach: Fwd = B is Low, or Tach: Fwd = B 
is High).

Illustration of Bi-Phase/Tach signals

Square Wave A

Square Wave B    



This explains how SYNC I/O can use a Bi-
Phase/Tach signal to deduce the direction, and 
how it also uses the signal as a clock reference—
as long as SYNC I/O is told the starting frame of 
the first clock signal.

Pilot Tone
SYNC I/O can resolve to an external Pilot Tone 
signal for synchronizing to (or transferring au-
dio from) certain types of open-reel audio tape 
recorders. 

In general, Pilot Tone is a sine wave reference 
signal running at the “line frequency” or “mains 
frequency,” meaning the same frequency trans-
mitted by the AC line voltage from the local 
power utility. 

Pilot Tone is used on location film shoots to es-
tablish a common sync reference between a film 
or video camera with a portable 1/4” analog ATR 
(such as those made by Nagra or Stellavox). On 
location, Pilot Tone is derived by clock referenc-
ing the camera to the local AC line frequency 
(which is 60Hz or 50Hz depending on the coun-
try of origin), and this same frequency is then 
used to clock-reference the ATR. The result is 
that both the camera and the ATR will run at the 
same speed. 

You can think of Pilot Tone as a kind of inex-
pensive and readily available “house sync” for 
location production. Increasingly, it’s being re-
placed by time code, since new-generation film 
cameras as well as many portable DAT recorders 
are time code-capable. 

Please note that Pilot Tone contains no posi-
tional information; it is simply a clock refer-
ence. Most 1/4-inch machines have a center 
track for time code or pilot.
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appendix b

Technical Specifications
General
Nominal Sample Rates 44056 Hz (Pull Down)

44100 Hz

44144 Hz (Pull Up)

47952 Hz (Pull Down)

48000 Hz

48048 Hz (Pull Up)

88200 Hz (Up/Down)

96000 Hz (Up/Down)

176400 Hz (Up/Down)

192000 Hz (Up/Down)

Frame Rates 30 fps

30 fps drop-frame

29.97 fps

29.97 fps drop-frame

25 fps

24 fps

Variable Speed Override ±699 cents (±58.25%) Actual range varies with sample rate
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Resolver Lock Time LTC: 750 msec

Video: 1.5 sec

Word Clock: 750 msec

AES/EBU: 750 msec

Bi-phase: 1.0 sec

Pilot: 1.1 sec (60 Hz), 1.3 sec (50 Hz)

Frequency Reference
Stability: ±5 ppm from 50 to 131 degrees F 

(10 to 55 degrees C)

Aging: ±2 ppm/year typical

Burn-in Window Position: 5 horizontal and vertical positions

Size: Large and small text

Color: Black or white text on white or black 
background or keyed 

Dimensions Height: 1RU/1.75” (4.45 cm) 

Width: 19.0” (48.26 cm)

Depth: 10.5” (26.67 cm)

Weight 5.0 lbs (2.27 kg)

Vibration Resistance 5 mm displacement, 10 to 55 Hz, each axis

Shock 5 G max

General
SYNC I/O Guide



Operating Temperature 32 to 131 degrees F (0 to 55 degrees C)

Storage Temperature -40 to 176 degrees F (-40 to 80 degrees C)

Relative Humidity 0 to 95%, non-condensing

Power Requirements Voltage: 85 to 264 VAC

Frequency: 47 to 63 Hz autoswitching

Wattage: 9.5 W typical, 30 W maximum

Connector: 3-pin, AC and ground (IEC 
950:320;3.2.4)

Agency Compliance
Meets FCC Part 15 Class A limits, CD EN 55022A, CE EN 60950, 
CE EN 55081:1, UL 1419 and CSA 22.2

General
Rear Panel Connectors
Connector Specifications

LTC In Format: SMPTE/EBU 80-bit longitudinal, drop frame/non-drop 
frame

Connector: 3-pin XLR female per IEC 268-12

Speed Range: 1/30 to 80X play speed, forward or backward

Level: –24 dBu to +9 dBu, differential (pin 2 hot)

Impedance: 200K ohms
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LTC Out Format: SMPTE/EBU 80-bit longitudinal, drop frame/non-drop 
frame

Connector: 3-pin XLR male per IEC 268-12

Speed Range: ±10% of play speed

Level: –24 dBu thru +9 dBu RMS, differential (pin 2 hot)

Level Default: 0 dBu RMS, 1.52V p-p ±10mV

Output Impedance: 5K ohms

Load Impedance (mini-
mum):

100 ohms

Rise/Fall Time: 42us ± 1us measured between 10% and 90% p-p

S/N Ratio: –60 dB RMS at 0 dBu level

Video (Main) In Format NTSC or PAL composite video

Level: 1V p-p

Termination: 75 ohms

Video (Main) Out Level: 1V p-p

Source Impedance: 75 ohms

Video (Ref) In Format: NTSC or PAL composite video

Rear Panel Connectors

Connector Specifications
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Level: 1V p-p

Termination: 100K ohms

Video (Ref) Out Level: 1V p-p

Termination: 100K ohms

Description: Passive loop-thru of Video Ref in

AES Clock In Level: 5 V p-p at 110 ohms (pin 2 hot)

Connector: 3-pin XLR female per IEC 268-12

AES Clock Out Level: 5 V p-p at 110 ohms (pin 2 hot)

Connector: 3-pin XLR male per IEC 268-12

Word Clock In Level: 0 to .5 V (low), 2.0 to 6.0 V (high)

Connector: BNC Female

Word Clock Out Level: TTL (3.3 V typical)

Connector: BNC Female

Loop Sync In Level 0 to .5 V (low), 2.0 to 6.0 V (high)

Connector BNC Female

Rear Panel Connectors

Connector Specifications
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Loop Sync Out Level TTL (3.3 V typical)

Connector BNC Female

Bi-phase/Tach/ Connector: 25-pin D-subminiature female (DB25)

GPI/Pilot

Bi-phase/Tach In Frequency Range: 0 to 76.8 KHz

Level: 4.5 to 12V, opto-isolated

Current: 10 mA max

Polarity (bi-phase): Both inputs are software programmable

Polarity (tach): “Direction” polarity is software programmable

Modulo Range: 2 thru 254

Pilot In Level: 100 mV to 5.5 V p-p, differential

Frequency Range: 50/60 Hz nominal

Impedance: 200K ohms

GPI In Description: Four opto-isolator inputs/returns

Level: 4.5 to 5.5 V

Current: 10 mA max

Frequency: Frame-rate max

Latency: Half frame max

Rear Panel Connectors

Connector Specifications
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GPI Out (TTL) Description: Two TTL-level outputs

Level: TTL (3.3 V typical)

Current: 15 mA

Frequency: Frame-rate max

Latency: Half-frame max

GPI (Relay) Description: Four pairs of SPST contacts, normally open

Load (while switching): .5 A max at 200 VDC

Load (continuous): 1.5 A max at 200 VDC

Operate/Release Time: 1 ms

Repetition Rate: Frame-rate max

Latency: Half frame max

MIDI Time Code 
(MTC) Out

Current Rating: 15 mA current loop

Rate: 31.25 Kilobaud

Connector: 5-pin DIN female

Cable Length: 50 feet (15 meters) max

Host Serial Format: Apple Macintosh-compatible serial printer port

Connector: 8-pin mini DIN female

Cable Length: 50 feet (15 meters) max

Rear Panel Connectors

Connector Specifications
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VITC In Format SMPTE 90-bit, drop frame/non-drop frame

Line Range: 10 to 40 (all-line mode), 10 to 22 (single-line mode)

VITC Out Format: SMPTE 90-bit, drop frame/non-drop frame

Line Range: Two lines, 10 to 20

Rear Panel Connectors

Connector Specifications
SYNC I/O Guide



appendix c

Wiring Diagrams Pin Assignments
LTC
The SYNC I/O LTC In and LTC Out connectors 
are balanced XLRs with Pin 2 wired “+” or “hot,” 
Pin 3 wired “–” or “cold,” and Pin 1 wired to 
ground (shield). Depending on whether you are 
connecting a balanced or unbalanced signal to 
these connectors, different wiring configura-
tions are recommended for optimum signal in-
tegrity, especially for long cable runs.

If you are connecting a balanced signal to the 
SYNC I/O LTC In or LTC Out connectors:

• Pin 1 and ground should be connected at the 
input only (not at the output). This will pre-
vent ground loops between the shield and the 
Pin 1 conductor.

If you are connecting an unbalanced signal to the 
SYNC I/O LTC In or LTC Out connectors:

• Connect only Pin 2 to the “+” signal;

• Connect Pin 1 to ground at all inputs and out-
puts. 
Refer to the following illustration for the correct 
wiring diagrams.

Wiring diagrams for the SYNC I/O LTC In and LTC Out 
connectors

-
GND

1 2

3

N.C.

Device

LTC Out

Connector

+

Balanced to Balanced Connection

-
GND

12

3

Device

LTC In

Connector

+

GND

1 2

3

Device

LTC Out

Connector

+

Balanced to Unbalanced Connection

GND

1 2

3

Device

LTC In

Connector

+
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BiPhase/GPI/Pilot 
SYNC I/O Guide
Bi-Phase/GPI/Pilot 
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Bi-phase/Tach OptoCoupler Input 
Bi-phase/Tach

XREF=13
BIPHB

XREF=13
BIPHA

XREF=9
BIPHA_I

XREF=9
BIPHB_I

U5

3

2

5

7

6

XREF=9
OPTRETURN

R79

R77

U6

3

2

5

7

6

R
4
9

C27

C25

R47

R46

5V

GND

6N137_DP

IC, OPTOCOUPLER

320003987

DIP8

+ EN

-

GND
8

VCC

GND

1K

1K

6N137_DP

IC, OPTOCOUPLER

320003987

DIP8

+ EN

-

GND8 VCC

5V

1
K

0.1UF

0.1UF

634

634

GND_C
Appendix C: Wiring Diagrams Pin Assignments 81



82
GPI Relay Outputs
SYNC I/O Guide
GPI Relay Output
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GPI (TTL)/MTC Outputs
GPI TTL/MTC Output
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GPI (opto) Inputs
SYNC I/O Guide
GPI (opto) Input
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Connector Pin Assignments

Connector Pin Assignments
Mac Serial 
Port

Pin # Name Description Mac Connection

1 NC No connection Pin 2 (HSKiB)

2 RTS_IN Request To Send (input to USD) Pin 1 (HSKoB)

3 RX_OUT Transmitted data (output from USD) Pin 5 input (RXDB–)

4 GND Chassis ground Ground

5 TX_IN Received data (input to USD) Pin 3 output 
(TXDB–)

6 GND Chassis ground Pin 8 input (RXDB+)

7 CTS_OUT Clear To Send (output from USD) Pin 7 input (GPiB)

8 NC No connection Pin 6 (TXDB+)

Shell GND Chassis ground Ground

Bi-phase/Tach/GPI/Pilot Port (Accessory Port)

Pin # Name Description

1 GPOUT0 GPI TTL-level output 0

2 GPOUT1 GPI TTL-level output 1

3 GPOUT0_A GPI Relay 0, contact A

4 GPOUT0_B GPI Relay 0, contact B

5 GPOUT1_A GPI Relay 1, contact A

6 GPOUT1_B GPI Relay 1, contact B

7 GPOUT2_A GPI Relay 2, contact A
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8 GPOUT2_B GPI Relay 2, contact B

9 GPOUT3_A GPI Relay 3, contact A

10 GPOUT3_B GPI Relay 3, contact B

11 OPTRETURN Return from Bi-phase/Tach opto-isolators

12 BIPHB_I Input to Bi-phase/Tach opto-isolator B

13 BIPHA_I Input to Bi-phase/Tach opto-isolator A

14 GND Chassis ground

15 PILOT_IN– Pilot tone input, negative

16 PILOT_IN+ Pilot tone input, positive

17 RET0 Return from GPI opto-isolator “0”

18 GPIN0 Input to GPI opto-isolator “0”

19 RET1 Return from GPI opto-isolator “1”

20 GPIN1 Input to GPI opto-isolator “1”

21 RET2 Return from GPI opto-isolator “2”

22 GPIN2 Input to GPI opto-isolator “2”

23 RET3 Return from GPI opto-isolator “3”

24 GPIN3 Input to GPI opto-isolator “3”

25 VDD +12V DC

Shell GND Connected to chassis ground

Connector Pin Assignments
SYNC I/O Guide



SYNC I/O Serial Cable Pin 
Assignments
(Macintosh)

The following table shows the pin assignments 
for DigiSerial Macintosh. 

(Windows)

The following table shows the pin assignments 
needed for a SYNC I/O-to-COM cable, to sup-
port SYNC I/O Setup on a Windows computer. 

DigiSerial for Macintosh

Mini DIN 8-pin Male to Mini 
DIN 8-pin Male

1 2

2 1

3 5

4 4

5 3

6 8

7 7

8 6

Host Serial for Windows

Mini DIN 8-pin Male to 9-pin 
D-Sub Female

2 7

3 2

4 5

5 3

7 8

Shell Shell

1, 6, 8 none 1, 4, 6, 9 
none
Bi-phase/Tach/GPI/Pilot Port 
Interfacing Notes
◆ The six opto-isolators are 6N137 devices. The 
four GPI input ports pass through 390 ohm se-
ries resistors to the cathode. The two Bi-
Phase/Tach inputs pass through 634 ohm series 
resistors to the cathode. 

◆ The two TTL-level GPI outputs are driven by a 
74FCT541. Each output passes through a 220 
ohm series resistor.

◆ 12 volts is supplied at the connector for the 
purpose of driving the opto-isolators in film 
tach applications. It is regulated and can supply 
up to 100mA. 

◆ For Tach, the “rate” input is “BIPHA_I” and 
the “direction” input is “BIPHB_I.” The polarity 
of “BIPHB_I” is software programmable and de-
faults to “low” for “forward.”

◆ For Bi-phase, the default polarity relationship 
between A and B is software programmable. The 
default setting for “forward” is “A leads B.” This 
means that the rising edge of A (0˚ phase) must 
precede the rising edge of B (90˚ phase).

◆ For highest signal quality, use a 25-pin cable 
with individually shielded conductors.
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GPI Relay Wiring for Fader-Start

The Universal Slave Driver provides a total of 
four Relay-level GPI outputs on pins 3/4, 3-10 of 
the DB25 connector (see the circuit diagram GPI 
(TTL)/MTC Outputs). 

The GPI Relay outputs are intended to drive Re-
lay loads only. 

GPI Triggers

GPI output signals information:

0 (relay) = Play

1 (relay) = Record Ready

2 (relay) = fader start #1

3 (relay) = fader start #2

4 (TTL) = Stop

5 (TTL) = Record

Logical GPI numbers 0 through 3 are associated 
with GPI relay outputs 0 through 3 (pins 3 
through 10). GPI numbers 4 and 5 are associated 
with GPI TTL outputs 0 and 1 (pins 1 and 2). 
SYNC I/O Guide
GPI TTL WIring

The circuit can drive approximately 2 mA 
through a load of 1.6K and maintain a logic 
high level of 3.3V. In an application where the 
equipment being controlled has more demand-
ing power requirements, an external buffer or 
relay circuit mst be used. This would typically be 
constructed as part of a custom electrical inter-
face. 

Each GPI TTL output is fully short-circuit pro-
tected via a 220-ohm series resistor. 

Before attempting to wire any type of custom in-
terface, always check the electrical specifications 
provided by the equipment manufacturer, in-
cluding voltage levels, current, loading and po-
larity. Incorrect wiring may damage your equip-
ment, your SYNC I/O or cause personal injury.
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